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1 Foreword

The DriveControlSuite commissioning software for 6th generation drive controllers offers convenient functions for efficient
project configuration and commissioning of drive controllers in multi-axis and single-axis applications.

The CiA 402 application included in the software contains both controller-based and drive-based operating modes along
with the associated position, velocity and torque/force control types. For commissioning, emergency operation and
maintenance or repair work, the STOBER-specific jog mode is also available.

This documentation describes the general functions of the CiA 402 application and guides you step by step through the
setup and project configuration of your drive project in the individual operating modes.
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2 User information

This documentation supports you in the setup and project configuration of your drive system with the CiA 402 application,
which is based on the internationally standardized CANopen CiA 402 device profile for electric drives in accordance with
IEC 61800-7.

Commissioning is described using examples of an EtherCAT network with STOBER drive controllers from the 6th generation
in combination with a CODESYS SoftMotion controller or, as an alternative, working with a controller from Beckhoff
Automation GmbH & Co. KG.

Technical knowledge

To be able to commission one or more drive controllers in combination with a controller using the CiA 402 application, you
should have basic knowledge of handling 6th generation STOBER drive controllers and of the DriveControlSuite
commissioning software. Operating an EtherCAT network also requires having familiarity with the basics of the EtherCAT
network technology.

Technical requirements

Before you begin operating your EtherCAT network, you need to wire the drive controllers and initially check that they are
functioning correctly. To do this, follow the instructions in the manual for the relevant drive controller.

2.1 Storage and transfer

As this documentation contains important information for handling the product safely and efficiently, it must be stored in
the immediate vicinity of the product until product disposal and be accessible to qualified personnel at all times.

Also pass on this documentation if the product is transferred or sold to a third party.

2.2 Described product

This documentation is mandatory for SD6 series drive controllers in conjunction with the DriveControlSuite software (DS6)
in V 6.7-A or later and associated firmware in V 6.7-A or later.

2.3 Directives and standards

Refer to the drive controller documentation for the European directives and standards relevant to the drive controller and
accessories.

2.4 Timeliness

Check whether this document is the latest version of the documentation. We make the latest document versions for our
products available for download on our website:
http://www.stoeber.de/en/downloads/.

2.5 Original language

The original language of this documentation is German; all other language versions are derived from the original language.
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2.6 Limitation of liability

This documentation was created taking into account the applicable standards and regulations as well as the current state of
technology.

No warranty or liability claims for damage shall result from failure to comply with the documentation or from use that
deviates from the intended use of the product. This is especially true for damage caused by individual technical
modifications to the product or the project configuration and operation of the product by unqualified personnel.

2.7 Formatting conventions

Orientation guides in the form of signal words, symbols and special text markups are used to emphasize specific
information so that you are able identify it in this documentation quickly.

2.71 Display of warning messages and information

Warning messages are identified with symbols. They indicate special risks when handling the product and are accompanied
by relevant signal words that express the extent of the risk. Furthermore, useful tips and recommendations for efficient,
error-free operation are specially highlighted.

ATTENTION!

Attention

This indicates that damage to property may occur

= if the stated precautionary measures are not taken.

/A cAUTION!

Caution

This word with a warning triangle indicates that minor personal injury may occur

= if the stated precautionary measures are not taken.

/A WARNING!

Warning

This word with a warning triangle means there may be a considerable risk of fatal injury

= if the stated precautionary measures are not taken.

2 | User information

A DANGER!

Danger
This word with a warning triangle indicates that there is a considerable risk of fatal injury

= if the stated precautionary measures are not taken.

Information

Information indicates important information about the product or serves to emphasize a section in the documentation that
deserves special attention from the reader.
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2.72 Markup of text elements

Certain elements of the continuous text are distinguished as follows.

Important information Words or expressions with a special meaning
Interpolated position mode Optional: File or product name or other name
Detailed information Internal cross-reference
http://www.samplelink.com External cross-reference

Software and other displays

The following formatting is used to identify the various information content of elements referenced by the software
interface or a drive controller display, as well as any user entries.

Main menu Window names, dialog box names, page names or buttons, combined
Settings proper nouns, functions referenced by the interface
Select Predefined entry

Referencing method A

Save your User-defined entry
<own IP address>

EVENT 52: Displays (status, messages, warnings, faults)
COMMUNICATION

Keyboard shortcuts and command sequences or paths are represented as follows.

[Ctrl], [Ctrl] + [S] Key, key combination

Table > Insert table Navigation to menus/submenus (path specification)

Operating buttons

The buttons of the drive controller are depicted as follows in the continuous text.

[OK] Button on the operating unit of the drive controller

10/2025 | ID 443077.03
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2.73 Mathematics and formulas

The following signs are used to represent mathematical relationships and formulas.

- Subtraction

+ Addition
X Multiplication
+ Division

| Absolute value

2.8 Trademarks

The following names used in connection with the device, its optional equipment and its accessories are trademarks or
registered trademarks of other companies:

CANopen’, CANopen’ and CiA” are registered trademarks of CAN in AUTOMATION e.V.,

CiA® Germany, the international user and manufacturer association.

CODESYS’ CODESYS' is a registered trademark of CODESYS GmbH, Germany.

EnDat’ EnDat’ and the EnDat’ logo are registered trademarks of Dr. Johannes Heidenhain

GmbH, Germany.

EtherCAT’, EtherCAT’ and TwinCAT are registered trademarks and patented technologies,

Safety over EtherCAT’ licensed by Beckhoff Automation GmbH, Germany.

HIPERFACE’ HIPERFACE® and the HIPERFACE DSL’ logo are registered trademarks of SICK AG,
Germany.

PLCopen’ PLCopen’ is a registered trademark of the PLCopen Organisation, Netherlands.

TwinCAT’ TwinCAT is a registered and licensed trademark of Beckhoff Automation GmbH,
Germany.

All other trademarks not listed here are the property of their respective owners.

Products that are registered as trademarks are not specially indicated in this documentation. Existing property rights
(patents, trademarks, protection of utility models) are to be observed.
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3 Safety notes

Risk of fatal injury if safety notes and residual risks are not observed!

Failure to observe the safety notes and residual risks in the drive controller documentation may result in accidents causing
serious injury or death.

= Observe the safety notes in the drive controller documentation.

= Consider the residual risks in the risk assessment for the machine or system.

Malfunction of the machine due to incorrect or modified parameterization!

In the event of incorrect or modified parameterization, malfunctions can occur on machines or systems which can lead to
serious injuries or death.

= Observe the security notes in the drive controller documentation.
= Protect the parameterization, e.g. from unauthorized access.

= Take appropriate measures for possible malfunctions (e.g. emergency off or emergency stop).

10
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4 What you should know before commissioning

The following chapters provide a quick introduction to the structure of the program interface and accompanying window
designations as well as relevant information about parameters and generally saving your project configuration.

4. Program interfaces

The following chapters include an overview of the program interfaces for the described software components.

411 DS6 program interface

Using the graphical interface of the DriveControlSuite commissioning software (DS6), you can project, parameterize and
commission your drive project quickly and efficiently. In case of service, you can evaluate diagnostic information such as
operating states, fault memories and fault counters of your drive project using DriveControlSuite.

Information

The program interface of DriveControlSuite is available in German, English and French. To change the language of the
program interface, select Settings > Language.

Information

The DriveControlSuite help in the menu bar can be reached via Help > Help for DS6 or via the [F1] key on your keyboard.
When you press [F1] in an area of the program, the corresponding help topic opens.

11
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Fig. 1: DS6: Program interface

1 Menu bar Using the File, View, Settings and Window menus, you can open and save projects, display
and hide program windows, select the interface language and access level and change
between different windows in the workspace.

2 Toolbar The toolbar enables quick access to frequently needed functions, like opening and saving
projects and hiding and displaying windows in the program interface.

3 Project tree The project tree forms the structure of your drive project in the form of modules and drive
controllers. Select an element using the project tree first in order to edit it using the
project menu.

4 Project menu The project menu offers you various functions for editing the project, module and drive
controller. The project menu adapts to the element that you selected in the project tree.

5 Workspace The different windows which can be used to edit your drive project, such as the
configuration dialog, wizards, the parameter list or the scope analysis tool, open in the
workspace.

6 Parameter check The parameter check points out irregularities and inconsistencies that were detected in

the plausibility check of calculable parameters.

7 Messages The entries in the messages log the connection and communication status of the drive
controllers, incorrect inputs caught by the system, errors when opening a project or rule
violations in the graphical programming.

8 Variable parameter You can use variable parameter lists to compile any parameters in individual parameter
lists lists for a quick overview.
9 Status bar In the status bar, you can find the specifications of the software version and get additional

information about the project file, the devices and the progress of the process during
processes such as loading projects.

12
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4111 Configuring the view

In DriveControlSuite, you can change the visibility and arrangement of areas and windows, such as to optimize the available
space in the workspace when working with smaller screens.

Showing/hiding areas

Use the icons in the toolbar or the items in the View menu to show or hide specific areas in DriveControlSuite as needed.

- Reset Resets the view to factory settings.
EEE Project Shows/hides the Project window (project tree, project
menu).
[ Messages Shows/hides the Messages window.
V/ Parameter check Shows/hides the Parameter check window.
. Variable parameter lists Shows/hides the Variable parameter lists window.

e

Arrange and group areas

You can undock and rearrange the individual areas via drag and drop. If you drag an undocked window to the edge of
DriveControlSuite, you can release it there in a color-highlighted area either next to or on top of another window to redock
it.

When you release the window onto another window, the two areas are merged into one window where you can use tabs to
switch between the areas.

13
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411.2 Navigation using sensitive circuit diagrams

Axis model

LIETypo efasks | D: Liser cafined, ratatiensl |
e
L2320 Motor encader | 23 B4-mender Bl

LM range (D Lmsied =1

Scaling axis

Motor

®
®

Fig. 2: DriveControlSuite: Navigation using text links and symbols

In order to graphically illustrate the processing sequence of actual and set values, the use of signals or the arrangement of
drive components and to make configuring the accompanying parameters easier, they are displayed on the respective
wizard pages of the workspace in the form of circuit diagrams.

Blue text links or clickable icons indicate links within the program. These refer to the corresponding wizard pages and, as a
result, allow you to reach additional helpful detail pages with a click.

14
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41.2

TwinCAT 3 program interface

In TwinCAT 3, you commission your EtherCAT system via the TwinCAT 3 Engineering development environment. The
following graphic shows the interface elements relevant to this documentation.

Fig. 3: TwinCAT 3 Engineering: Program interface

1

Menu bar

Toolbar

Solution explorer

Main window (editor)

Message window

Properties window

Toolbox

Information and status
bar

The menu bar shows the menus set by default. Editor-specific menus appear only when the
corresponding editor is open. Using the Tools menu, you can configure the programming
interface and add to existing menus or define new ones, for example.

The toolbar enables quick access to frequently used functions, such as opening and saving
projects.

The solution explorer maps the structure of your project with the project elements it
contains. First select an element using the solution explorer to edit it in the editor.

In the editor, you define and edit objects, e.g. graphical programming elements.

The Messages window informs you of any errors or warnings currently present. You also
receive messages about the syntax check, compilation process, etc.

The properties window shows the properties of the element selected in the solution
explorer.

The toolbox displays the tools available for the active editor, such as graphical
programming elements.

The information and status bar informs you about the state of the system (Config, Run,
Stop or Exception mode). In online operation, you can see the current status of the
program. If an editor window is active, the current position of the cursor and the set
editing mode may also be displayed.
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41.3

CODESYS Development System V3 program interface

You can commission your EtherCAT system via the graphical user interface of the CODESYS Development System V3
programming software for industrial control and automation technology. The following graphic shows the interface

elements relevant to this documentation.

Fig. 4: CODESYS Development System V3: Program interface

1

Menu bar

Toolbar

Device tree

Main window (editor)

Tools

Messages

Information and status
bar

The menu bar shows the menus set by default. Editor-specific menus only appear if the
corresponding editor is active. Using the Tools menu, you can configure the programming
interface and add to existing menus or define new ones, for example.

The toolbar enables quick access to frequently used functions, such as opening and saving
projects.

The device tree (Devices tab) shows the structure of your project with the device objects it
contains. First select a device from the device tree to edit it in the editor.

In the editor, you define and edit objects, e.g. device settings and function blocks.

The Tools window displays the tools available for the active editor, e.g. graphical
programming elements or elements for visualization.

The Messages window informs you of any errors or warnings currently present. You also
receive messages about the syntax check, compilation process, etc.

The information and status bar informs you about the state of the system and the current
number of active errors and warnings. If an editor window is active, the current position of
the cursor and the set editing mode may also be displayed.
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4.2 Meaning of parameters

You can use parameters to adapt the function of the drive controller to your individual application. In addition, parameters
visualize the current actual values (actual velocity, actual torque, etc.) and trigger actions such as Save values, Test phase,
etc.

Interpretation of parameter identification

Parameter identification consists of the following elements, where short forms are also possible, i.e. only specifying a

coordinate or the combination of coordinate and name.

E50| Drive controller | G6 | \[1)
| | |

Coordinate Name Version

Drive controller
generation/series

4.21 Parameter groups
Parameters are assigned to individual groups by topic. The drive controllers differentiate between the following parameter
groups.
A Drive controllers, communication, cycle times
B Motor
C Machine, velocity, torque/force, comparators
D Set value
E Display
F Terminals, analog and digital inputs and outputs, brake
G Technology — Part 1 (application-dependent)
H Encoder
| Motion (all motion settings)
J Motion blocks
K Control panel
L Technology — Part 2 (application-dependent)
M Profiles (application-dependent)
N Additional functions (application-dependent; e.g. extended cam control unit)
P Customer-specific parameters (programming)
Q Customer-specific parameters, instance-dependent (programming)
R Production data for the drive controller, motor, brakes, motor adapter, gearbox and geared motor
S Safety (safety technology)
T Scope
V] Protection functions
z Fault counter

Tab. 1: Parameter groups
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4.2.2

Parameter types and data types

In addition to topic-based sorting in individual groups, all parameters belong to a certain data type and parameter type. The

data type of a parameter is displayed in the parameter list, properties table. The connections between parameter types,

data types and their value range can be found in the following table.

Data type Parameter type Length Value range (decimal)

INT8
INT16
INT32

BOOL

BYTE
WORD
DWORD

REAL32
(single type according to
IEE754)

STR8
STR16
STR80

Integer or selection
Integer

Integer or position

Binary number

Binary number
Binary number

Binary number or parameter
address

Floating-point number

Text
Text

Text

1 byte (signed)
2 bytes (1 word, signed)

4 bytes (1 double word,
signed)

1 bit (internal:
LSB in 1 byte)

1 byte (unsigned)
2 bytes (1 word, unsigned)

4 bytes (1 double word,
unsigned)

4 bytes (1 double word,
signed)

8 characters
16 characters

80 characters

Tab. 2: Parameters: Data types, parameter types, possible values

Parameter types: Use

= Integer, floating-point number

For general computing processes

Example: Set and actual values

= Selection

Numeric value to which a direct meaning is assigned

Example: Sources for signals or set values

= Binary number

Bit-oriented parameter information that is collected in binary

Example: Control and status words

= Position

Integer combined with associated units and decimal places

Example: Actual and set values of positions

= Velocity, acceleration, deceleration, jerk

Floating-point number combined with associated units

Example: Actual and set values for velocity, acceleration, deceleration, jerk

= Parameter address

Referencing of a parameter

Example: In F40 AO1 source, for example, EO8 n-motor filtered can be parameterized

= Text

Outputs or messages

-128 -127
-32768 — 32767

-2 147 483 648 -
2147 483 647

0,1
0-255
0-65535

0-4294 967 295

-3.40282 x 10* - 3.40282 x
10%
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4.2.3 Parameter types

The following types of parameters are differentiated.

Simple parameters

Array parameters

Consist of one group and one line with a A21 Brake resistor R: Value = 100 ohms
defined value.

Consist of a group, a line and multiple A10 Access level
sequential (listed) elements, which have the

same properties but different values. = A10[0] access level: Value = Access level

via operating unit

= A10[2] access level: Value = Access level
via CANopen and EtherCAT

= A10[4] access level: Value = Access level

via PROFINET

Record parameters Consist of a group, a line and multiple A0O Save values
sequential (listed) elements, which can have
different properties and different values.

= AOQ0[1] Progress: Value = Display action

progress

= A00[2] Result: Value = Display action

result

Tab. 3: Parameter types

4.2.4 Parameter structure

Every parameter has specific coordinates with the following structure.

1. E250(2] .3
T

Line
Group  Element
Axis Bit
= Axis (optional)
In case of multiple axes, the one to which a parameter is assigned; not applicable for global parameters
(value range: 1—4).

= Group
The thematic group to which a parameter belongs (value range: A —Z).
= Line
Distinguishes the parameters within a parameter group (value range: 0 — 999).
= Element (optional)
Elements of an array or record parameter (value range: 0 — 16000).
= Bit (optional)
Selection of a single bit for complete data addressing; depends on the data type (value range: 0 — 31).

= AQ0[O] Start: Value = Start action
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4.2.5 Parameter visibility

The visibility of a parameter is controlled by the access level you set in DriveControlSuite and by the properties you project
for the respective drive controller (e.g. hardware, firmware and application). A parameter can also be shown or hidden
depending on other parameters or settings. For example, the parameters of an additional function are only shown as soon
as you activate the relevant additional function.

Access level

The access options for the individual software parameters are ranked hierarchically and divided into individual levels. This
means that parameters can be hidden for a specific purpose and, relatedly, their configuration options can be locked
starting from a specific level.

Each parameter has one access level for read access (visibility) and one access level for write access (editability). The
following levels are present:

= Level 0

Elementary parameters

= Level 1

Important parameters of an application

= Level 2

Important parameters for service with extensive diagnostic options

= Level 3

All parameters needed for commissioning and optimizing an application
The parameter A10 Access level controls general access to parameters:
= Qver the drive controller display (A10[0])
= Qver CANopen or EtherCAT (A10[2])

= Over PROFINET (A10[3])

Hardware

Which parameters are available to you in DriveControlSuite is determined by which series you select in the configuration
dialog for the drive controller, for example, or whether you project an option module. Basically, the only parameters that
are displayed are the ones you need to parameterize the configured hardware.

For example, a drive controller can evaluate an encoder using terminal X120, provided that a corresponding terminal
module has been installed. The accompanying evaluation is activated using parameter H120. However, this parameter is
visible only if the terminal module was initially selected during the drive project configuration.

Firmware

Due to the further development and updating of functions for the drive controllers, new parameters and also new versions
of existing parameters are continuously being implemented in DriveControlSuite and in the firmware. The parameters are
displayed in the software according to the DriveControlSuite version used and the configured firmware version of the
respective drive controller.

Applications
Applications generally differ in terms of functions and their control. For this reason, different parameters are available with

each application.

Information

If a parameter exists in the configuration due to the projected properties of the drive controller (e.g. hardware, firmware,
application), it is generally available for fieldbus communication. The visibility of a generally available parameter has no
effect on its availability for fieldbus communication (e.g. through access level or parameter selection).
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4.3 Signal sources

Drive controllers are controlled either by a fieldbus, by terminals or by mixed operation consisting of a fieldbus system and
terminals. You can use the corresponding selection parameters, referred to as signal sources, to configure in
DriveControlSuite whether the control signals and set values of the application are obtained over a fieldbus or using
terminals.

In case of activation by using terminals, the respective analog or digital inputs are specified directly as the source. In case of
activation by fieldbus, parameters are selected as sources for control signals and set values, which must be part of the
process data mapping between the controller and drive controller so that the controller can write to them via fieldbus.

4.4 Non-volatile memory

All project configurations, parameterizations and related changes to parameter values are in effect after transmission to the
drive controller, but are only stored in volatile memory.

Saving to a drive controller
To save the configuration in non-volatile memory on a drive controller, you have the following options:

= Saving the configuration using the Save values wizard:
Project menu > Wizards area > Projected axis > Save values wizard:
Select the Save values action

= Saving the configuration using the parameter list:
Project menu > Parameter list area > Projected axis > Group A: Drive controller > A0O Save values:
Set the parameter A0O[0] to the value 1: Active

= Saving the configuration using the operating unit:
Press the save button for 3 s

Saving to all drive controllers within a project

To save the configuration in non-volatile memory on several drive controllers, you have the following options:

= Saving the configuration using the toolbar:
Toolbar > Save values icon: Click the Save values icon

= Saving the configuration using the Online functions window:
Project menu > Online connection button > Online functions window: Click on Save values (A00)

Information

Do not shut off the drive controller while saving. If the supply voltage to the control unit is interrupted while saving, the
drive controller will start without an executable configuration the next time it is switched on. To successfully complete the
saving procedure, the configuration must be stored again on the drive controller and in non-volatile memory.
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5 Commissioning

Are you looking to operate drive controllers with a controller over an EtherCAT network?

The following chapters describe commissioning using DriveControlSuite in combination with the TwinCAT 3 Engineering

automation software or CODESYS Development System V3.

We assume the following system environment as an example so that you can follow the individual commissioning steps

exactly:
= Drive controllers of the SD6 series in firmware version 6.7-A or later
= DriveControlSuite commissioning software version 6.7-A or later
in combination with
= Beckhoff controller
= Beckhoff TwinCAT 3 Engineering automation software
or in combination with
= CODESYS SoftMotion controller

= CODESYS Development System automation software

Commissioning is divided into the following steps:

1.  DriveControlSuite
Project all of the drive controllers, i.e. application type, device control systems, process data for fieldbus
communication and mechanical axis model in DriveControlSuite.
Depending on the selected application (CiA 402 or CiA 402 HiRes Motion), scale your axis models on the drive
controller side or the controller side.

In both cases, transfer your configuration to the drive controllers of the system network.

2. Automation software

Scale your axis model if necessary and then map your entire hardware environment in the respective software.

Synchronize the operation of the distributed clocks in all EtherCAT nodes and configure the communication of
individual nodes over the EoE protocol.

Finally, transfer the entire configuration to the controller and then start up your EtherCAT system.
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5.1 DS6: Configuring the drive controller

Project and configure all drive controllers for your drive system in DriveControlSuite (see also DS6 program interface [P 11]).

Information
Always perform the steps described below in the specified order!

Some parameters are interdependent and do not become accessible to you until you have first configured certain settings.
Follow the steps in the specified sequence so that you can finish the parameterization completely.

511 Initiating the project

In order to be able to configure all drive controllers and axes of your drive system using DriveControlSuite, you must record
them as part of a project.

5111 Projecting the drive controller and axis

Create a new project and project the first drive controller along with the accompanying axis.

Information

Make sure that you project the correct series in the Drive controller tab. The projected series cannot be changed
afterwards.

Creating a new project
1. Start DriveControlSuite.
2. Onthe start screen, click Create new project.

= The new project is created and the configuration dialog for the first drive controller opens.

= The Drive controller button is active.
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Projecting the drive controller

1. Properties tab:

Establish the relationship between your circuit diagram and the drive controller to be projected in DriveControlSuite.

1.1. Reference:

Define the reference code (equipment code) of the drive controller.

1.2. Designation:

Give the drive controller a unique name.

1.3. Version:

Version your project configuration.

1.4. Description:

If necessary, save additional supporting information (e.g., the change history).

2. Drive controller tab:

Select the series and device type of the drive controller.

3. Option modules tab:

Project the option modules of the drive controller.

3.1. Communication module:

Select the EC6 communication module for the transmission of EtherCAT process data.

3.2. Terminal module:
If you are controlling the drive controller via analog and digital inputs, select the corresponding terminal
module.

3.3. Safety module:
If the drive controller is part of a safety circuit, select the corresponding safety module.

4. Device control tab:

Project the basic control of the drive controller.

4.1. Device control:

Select CiA 402 device control.

4.2. Process data Rx, Process data Tx:

Select EtherCAT Rx or EtherCAT Rx SDO Info and EtherCAT Tx for transmitting the EtherCAT process data.

4.3. If you are working with hardware and software products from Beckhoff and are using the SDO Info service,
select EtherCAT Rx SDO Info and EtherCAT Tx for the transmission of the EtherCAT process data. You set up the

SDO Info service in TwinCAT 3. For more information, refer to the manual for communication with EtherCAT.

4.4. |If you are working with a CODESYS SoftMotion controller and the CODESYS V3 automation software, select
EtherCAT Rx and EtherCAT Tx for transmitting the EtherCAT process data.

ATTENTION!

Change of addressing when changing the template

If you change the template from EtherCAT Rx to EtherCAT Rx SDO Info, the addressing of the elements of array and record
parameters also changes. Note this in particular for existing configurations. For the templates, various ESl files are created.
When changing the template, you must create a new ESl file using the wizards in DriveControlSuite and provide it to
TwinCAT 3.
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Projecting the axis

1.

2.

Click Axis 1.

Properties tab:
Establish the relationship between your circuit diagram and the axis to be projected in DriveControlSuite.

2.1. Reference:

Define the reference code (equipment code) of the axis.

2.2. Designation:

Give the axis a unique name.

2.3. Version:

Version your project configuration.

2.4. Description:

If necessary, save additional supporting information (e.g., the change history).

Application tab:
Select the desired controller-based application CiA 402 or CiA 402 HiRes Motion.

3.1. If you are working with hardware and software products from Beckhoff, we recommend CiA 402 (incremental

version).

3.2. If you are working with a CODESYS SoftMotion controller and the CODESYS V3 automation software, we

recommend CiA 402 HiRes Motion (version with user-defined units of measure).

Motor tab:
Select the type of motor you operate with this axis. If you are working with motors from third-party suppliers, enter

the accompanying motor data later.

Confirm with OK.

511.2 Configuring safety technology

If the drive controller is part of a safety circuit, you must configure the safety technology in accordance with the

commissioning steps outlined in the corresponding manual in the next step (see Detailed information [P 145]).
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5113 Creating other drive controllers and modules

In DriveControlSuite, all drive controllers within a project are grouped using modules. If you add a new drive controller to
your project, be sure to always assign it to an existing module. Group drive controllers in a module if, for example, they are
located in the same control cabinet or work together to operate the same machine part.

Creating a drive controller
1. Inthe project tree, select your project P1 > module M1 > context menu Create new drive controller.

= The drive controller is created in the project tree and the configuration dialog opens.
2. Project the drive controller as described in Projecting the drive controller and axis.

3. Repeat the steps for all other drive controllers that you want to project.

Creating a module
1. Inthe project tree, select your project P1 > context menu Create new module.
= The module is created in the project tree.

2. Project the module as described in Projecting the module [» 26].

3. Repeat the steps for all other modules that you want to project.

5114 Projecting the module

Give your module a unique name, enter the reference code and, as an option, store additional information like the version
and change history of the module.

1. Select the module in the project tree and click on Project configuration in the project menu.
= The configuration dialog for the module opens.
2. Establish the relationship between your circuit diagram and the module in DriveControlSuite.

2.1. Reference:

Define the reference code (equipment code) of the module.

2.2. Designation:

Give the module a unique name.

2.3. Version:

Version the module.

2.4. Description:
If necessary, save additional supporting information (e.g., the change history).

3. Confirm with OK.
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511.5 Projecting the project

Give your project a unique name, enter the reference code and, as an option, store additional information like the version
and change history of the project.

1. Select the project in the project tree and click on Project configuration in the project menu.
= The configuration dialog for the project opens.
2. Establish the relationship between your circuit diagram and the project in DriveControlSuite.

2.1. Reference:

Define the reference code (equipment code) of the project.

2.2. Designation:

Give the project a unique name.

2.3. Version:

Version the project.

2.4. Description:

If necessary, save additional supporting information (e.g., the change history).

3. Confirm with OK.

512 Mapping the mechanical axis model

To be able to put your real drive train with one or more drive controllers into operation, you must map your complete
mechanical environment in DriveControlSuite.

The 6th generation of STOBER drive controllers are specially developed for communication between the drive controller
and controller on the basis of the actual variables at the output (° or mm of real axis movement). The scaling of the axis
model is calculated by the drive controller's firmware independently of the encoder model, without any rounding errors or
drift.

Information

The scaling of the axis depends on whether you have configured the CiA 402 or CiA 402 HiRes Motion application: For the
CiA 402 HiRes Motion application, scale the axis for the drive controller in the DriveControlSuite; for the incremental
version CiA 402, scale the axis in the controller.

When scaling the axis, follow the instructions for the application you are projecting.

51.21 Parameterizing the motor
You have projected a synchronous servo motor with EnDat 2.1/2.2 digital encoder and optional brake.

When the project is configured for the corresponding motor, limiting values for currents and torques as well as associated
temperature data are automatically transferred to the respective parameters of the individual wizards. All additional data
on the brake and encoder is transferred at the same time.

51.2.2 Parameterizing the axis model

Parameterize the setup of your drive in this order:
= Define the axis model
= Scale the axis
= Parameterize the position and velocity window
= Limit the axis (optional)
e Limit the position
e Limit the velocity, acceleration and jerk

e Limit the torque and force
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51.2.21 Defining the axis model

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Axis model wizard.

3. 105 Type of axis:

Define whether the axis type is rotational or translational.

3.1. If you have projected the CiA 402 application, or if you would like to configure the units of measure and the
number of decimal places for the CiA 402 HiRes Motion application individually for specifying and displaying

positions, velocities, accelerations and jerk, select 0: User defined, rotational or 1: User defined, translational.

3.2. If you have projected the CiA 402 HiRes Motion application and the units of measure and the number of
decimal places for specifying and displaying positions, velocities, accelerations and jerk are to be fixed, select
2: Rotational or 3: Translational.

4. B26 Motor encoder:

Select the interface to which the motor encoder is connected.

5. 102 Position encoder:

Select the interface to which the position encoder is connected.

6. 100 Position range:
Select whether the travel range of the axis is limited or endless (modulo). The CiA 402 application requires the 0:

Limited selection; the 1: Endless selection is only possible for the CiA 402 HiRes Motion application.

Information

When you parameterize 105 Type of axis, you can either use selection 0: User defined, rotational or 1: User defined,
translational to configure units of measure and the number of decimal places for the axis model individually or use
selections 2: Rotational and 3: Translational to revert to preset values.

Selection 0: User defined, rotational and selection 1: User defined, translational let you configure the unit of measure (109)
and the decimal places (106) individually. Velocity, acceleration and jerk are represented as the derivative of the unit of
measure with respect to time.

Selection 2: Rotational sets the following units of measure for the axis model: position in °, velocity in rpm, acceleration in
rad/s?, jerk in rad/s.

Selection 3: Translational sets the following units of measure for the axis model: position in mm, velocity in m/s,
acceleration in m/s?, jerk in m/s>.

Information

If you do not parameterize it differently for 102 Position encoder, B26 Motor encoder is used for position control as
standard.
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51.2.2.2 CiA 402: Scaling an axis

If you have projected CiA 402, you mainly scale the axis in the control software and only define the polarity of the axis in
DriveControlSuite (parameter: A571).

v’ You have projected CiA 402 (incremental version).

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >

Wizard area.
2. Select the Axis model wizard > Axis: Scaling.

3. A585[0] Feed constant. Feed®, A585[1] Feed constant.Shaft revolutions?:
Leave the preset A585[0] at 1048576 inc (= 20 bits = 2%°) and A585[1] at 1 U and adjust the corresponding value in the

control software.

4. 106 Decimal places position:

Leave the default value at 0.

5. A571 Polarity:
Use the polarity to define the direction of interpretation between the axis movement and motor movement.

Information

Parameter 1297 Maximum speed position encoder must be parameterized according to your application case. If 1297 is set
too low, the permitted maximum speed is exceeded even at normal operating speeds. On the other hand, if 1297 is set too
high, measuring errors of the encoder can be overlooked.

1297 depends on the following parameters: 105 Type of axis, |06 Decimal places position, 109 Measure unit as well as
107 Distance factor numerator position and 108 Distance factor denominator position or A585 Feed constant for CiA 402. If
you have made changes to one of the parameters listed, select 1297 accordingly as well.

! Corresponds to object 6092 hex, subindex 1 hex
2 Corresponds to object 6092 hex, subindex 2 hex
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51.2.23 CiA 402 HiRes Motion: Scaling an axis

If you have projected CiA 402 HiRes Motion, you mainly scale the axis in DriveControlSuite and only enter the number of

decimal places in the control software (parameter: 106).

v" You have projected CiA 402 HiRes Motion.

1.

Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

Select the Axis model wizard > Axis: Scaling.

A584[0] Gear ratio.Motor revolutions, A584[1] Gear ratio.Shaft revolutions:

Define the gear ratio (gearbox input revolutions per gearbox output revolutions).

A585[1] Feed constant.Shaft revolutions, A585[0] Feed constant. Feed:

Define the feed (feed distance per gearbox output revolutions).

106 Decimal places position:
If you selected 0: User defined, rotational or 1: User defined, translational for 105, define the number of decimal

places for positions. A change to 106 moves the decimal separator for all position values.

109 Measure unit:

If you selected 0: User defined, rotational or 1: User defined, translational for 105, define the unit of measure.

A571 Polarity:

Use the polarity to define the direction of interpretation between the axis movement and motor movement.

A568 Position range limit:

If you selected 1: Endless for 100, enter the revolution length of the axis.

Information

Parameter 1297 Maximum speed position encoder must be parameterized according to your application case. If 1297 is set

too low, the permitted maximum speed is exceeded even at normal operating speeds. On the other hand, if 1297 is set too

high, measuring errors of the encoder can be overlooked.

1297 depends on the following parameters: 105 Type of axis, |06 Decimal places position, 109 Measure unit as well as

107 Distance factor numerator position and 108 Distance factor denominator position or A585 Feed constant for CiA 402. If

you have made changes to one of the parameters listed, select 1297 accordingly as well.

51.2.2.4 Parameterizing the position and velocity window

Enter position limits and velocity zones for set values. To do so, parameterize boundary values for reaching a position or

velocity.
1. Select the Axis model wizard > Window position, velocity.
2. C40 Velocity window:
Parameterize a tolerance window for velocity tests.
3. 122 Target window:
Parameterize a tolerance window for position tests.
4. 187 Actual position in window time:

Parameterize how long a drive must stay in the specified position window before a corresponding status message is
output.
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51.2.25 Limiting the axis

As an option, you can limit the maximum permitted motion variables of position, velocity, acceleration, jerk and torque/
force according to your application.

Information

To simplify the scaling and limiting of the axis, the Axis model wizard > Axis: Scaling provides you with the Conversion of
position, velocities, accelerations, torque/force scaling calculator, which calculates the effects of changed motion variables
on the entire system. You can use the scaling calculator to enter values for motion variables of the motor, gearbox output
and axis in order to convert the values to all other locations in the axis model.

Limiting the position

To secure the travel range of the axis, you have the option to limit the permitted positions using a software or hardware
limit switch.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >

Wizard area.
2. Select the Axis model wizard > Limit: Position.

3. 1101 Source positive /limit switch, 1102 Source negative /limit switch:
To limit the travel range of the axis in the positive or negative direction of motion via hardware limit switches, select

the source of the digital signal that is used to evaluate a limit switch at the positive or negative end of the travel range.
3.1. If bit 1 or bit 2 of the control word 1210 of the application is the source, select 2: Parameter.
3.2. If adigital input (direct or inverted) acts as the source, select the corresponding input.

4. 150 Software stop positive, 151 Software stop negative:
If you selected 0: Limited for 100 and would like to limit the travel range of the axis via software limit switches, define

the largest or smallest permitted position for software position limiting.

ATTENTION!

Material damage due to leaving the permitted travel range

When a limit switch is overshot, the axis at the end of the permitted travel range will go into a fault condition, either with
or without a quick stop depending on the parameterization of the device control, so it may come to a standstill past the
limit switch and outside the permitted travel range.

= Allow sufficient space past the limit switch for your application to bring the axis to a standstill.

31



5 | Commissioning STOBER

Limiting velocity, acceleration, jerk

As an option, you can limit the motion variables of velocity, acceleration and jerk and define the quick stop deceleration

according to your application. The default values are designed for slow velocities without gearboxes.

1.

2.

Select the Motor wizard.

B83 v-max motor:

Determine the maximum permitted velocity of the motor.
Select the Axis model wizard > Axis: Scaling.

Conversion of positions, velocities, accelerations, torque/force area:
Use the scaling calculator to determine the maximum permitted velocity of the motor and the maximum permitted

velocity of the output as a reference value.
Select the Axis model wizard > Limit: Velocity, acceleration, jerk.

110 Maximal speed:
Define the maximum permitted velocity of the output according to your application (taking into account the

previously determined reference value).

111 Maximal acceleration:

Define the maximum permitted acceleration for the output.

116 Maximal jerk:
Define the maximum permitted jerk for the output.

117 Quickstop deceleration:

Define the desired quick stop deceleration for the output.

Limiting the torque/force

As an option, you can limit the torque/force according to your application. The default values take into account the rated
operation together with the overload reserves.

1.

2.

Select the Axis model wizard > Limit: Torque/force.

C03 Maximum positive torque/force, CO5 Maximum negative torque/force:

Define the maximum permitted set torque/maximum permitted set force.

C08 Maximum torque/force for quick stop:
Define the maximum permitted set torque/maximum permitted set force in case of a quick stop and in case of drive-
controlled emergency stop SS1, SS1 and SS2.
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513 Parameterizing general EtherCAT settings

v" You have projected a device control with the process data as part of drive controller and axis projecting.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >

Wizard area.
2. Select the EtherCAT wizard.

3. Fieldbus scaling A213:

Leave the preset at 1: Native (values are passed unchanged).

4. A258 EtherCAT PDO-Timeout:
To allow detection of a communication failure, define the tolerated failure time for monitoring the receive PDO (value

range: 0 — 65535 ms). For more information, refer to the parameter description of A258.

5. Optional: If you would like to use the SDO Info service, define which objects the controller can read out via SDO Info
using A268.

514 Configuring PDO transmission

PDO channels provide real-time transmission of control and status information, as well as actual and set values, from an
EtherCAT MainDevice to EtherCAT SubDevices and vice versa.

PDO communication allows for 4 PDO channels to be operated simultaneously per transmission and sending direction. A
maximum of 6 parameters can be transmitted in a defined sequence per process data channel. The process data can be
configured in any way.

In order to guarantee error-free communication between the controller and the drive controller, STOBER offers application-
dependent pre-assignment of the process data channels, which you can adapt to your specific application. Further
information on standard mapping can be found in the manual for the respective application.

If you make changes to the process data mapping, you must make these both on the drive controller in the
DriveControlSuite and in the control software.

51.4.1 Adapting RxPDO

v" You have configured the global EtherCAT settings.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >

Wizard area.
2. Select the EtherCAT wizard > Received process data RxPDO.

3. Check the preset process data and configure it according to your requirements if necessary.

51.4.2 Adapting TxPDO

v" You have configured the global EtherCAT settings.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >

Wizard area.
2. Select the EtherCAT wizard > Transmitted process data TxPDO.

3. Check the preset process data and configure it according to your requirements if necessary.
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515 Synchronizing EtherCAT nodes

Precise synchronization of the EtherCAT nodes is absolutely required for spatially distributed processes that require
simultaneous actions (path interpolation). EtherCAT provides the distributed clocks (DC-Sync) method for this.
Synchronization using distributed clocks is more precise than SyncManager event synchronization (SM-Sync) because it is
subject to fewer fluctuations. For this reason, DC-Sync is preconfigured in EtherCAT MainDevice and SubDevices.

PLL synchronization wizard

Leave the presets in the first step and optimize them if necessary once you have commissioned the EtherCAT network and
can assess and evaluate the quality of communication.

More information on synchronization and how to adjust it afterwards can be found in the manual for communication with
EtherCAT.

5.1.6 Creating an ESl file

If you are working with TwinCAT 3, create an ESI file for the controller for each series of the drive controller as described
below. The ESI file contains all the relevant data of an EtherCAT SubDevice that must be read into the EtherCAT MainDevice
to configure the EtherCAT system with TwinCAT 3.

TwinCAT 3 can only read in one ESlI file per series of the drive controller, i.e. if you use different applications or PDO
transmissions for the same series, you must extend your ESI file accordingly.

If you make changes to the project configuration or the PDO transmission in the meantime, you must generate a new ESI
file and make it available to TwinCAT 3.

Further information on ESI files can be found in the EtherCAT manual.

v" You have completed the configuration of PDO transmission.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the EtherCAT wizard.

3. Click on Create new ESI.
= The Write ESI dialog box opens.

4. Save the ESl file (*.xml) in the directory where the controller will read it from (TwinCAT 3 Engineering default
installation: C:\TwinCAT\3.1\Config\|O\EtherCAT).

= The ESI file is imported the next time TwinCAT 3 Engineering is started.
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517 Transmitting and saving a configuration

In order to transmit and save the configuration to one or more drive controllers, you must connect your PC and the drive
controllers over the network.

/A WARNING!

Injury to persons and material damage due to axis movement!

If there is an online connection between DriveControlSuite and the drive controller, changes to the configuration can lead
to unexpected axis movements.

= Only change the configuration if you have visual contact with the axis.
= Make sure that no people or objects are within the travel range.

= For access via remote maintenance, there must be a communication link between you and a person on site with eye
contact to the axis.

Information

During the search, all drive controllers within the broadcast domain are found via IPv4 limited broadcast.

Requirements for finding a drive controller in the network:
= Network supports IPv4 limited broadcast

= All drive controllers and the PC are in the same subnet (broadcast domain)

51.71 Transmitting the configuration

The steps for transmitting the configuration vary depending on the safety technology.

Drive controller without SE6 option (advanced safety technology)
v" The drive controllers are switched on and can be found in the network.

1. Inthe project tree, select the module under which you have recorded your drive controller and click Online

connection in the project menu.

= The Add connection dialog box opens. All drive controllers found via IPv4 limited broadcast are displayed.

2. Direct connection tab, IP address column:

Activate the IP addresses in question and confirm your selection with OK.

= The Online functions window opens. All drive controllers connected through the selected IP addresses are
displayed.

3. Select the module and the drive controller to which you would like to transfer the configuration. Change the selection

of transmission type from Read to Send.

4. Change the selection Create new drive controller:

Select the configuration that you would like to transfer to the drive controller.
5. Repeat steps 3 and 4 for all other drive controllers to which you would like to transfer your configuration.

6. Online tab:

Click Establish online connections.

= The configurations are transferred to the drive controllers.
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Drive controller with SE6 option (advanced safety technology)

v" The drive controllers are switched on and can be found in the network.

1.

In the project tree, select the module under which you have recorded your drive controller and click Online

connection in the project menu.

= The Add connection dialog box opens. All drive controllers found via IPv4 limited broadcast are displayed.

Direct connection tab, IP address column:

Activate the IP addresses in question and confirm your selection with OK.

= The Online functions window opens. All drive controllers connected through the selected IP addresses are
displayed.

Select the module and the drive controller to which you would like to transfer the configuration. Change the selection

of transmission type from Read to Send.

Change the selection Create new drive controller:

Select the configuration that you would like to transfer to the drive controller.
Repeat steps 3 and 4 for all other drive controllers to which you would like to transfer your configuration.

Online tab:

Click Establish online connections.
The configurations are transferred to the drive controllers.
The PASmotion Safety Configurator configuration tool opens.

In the project administration, navigate from PASmotion Safety Configurator to the safety module for the drive

controller and double-click to open it.
= The wizard for device synchronization opens.

= The project configuration and device configuration are checked against each other.

If the configurations match, click Done after device synchronization has finished.

Optional: If the configurations do not match, click Next after device synchronization has finished.
3.1. Confirm the serial number of the safety module and click Next.

3.2. Enter the password for the configuration on the safety module and click Next.

3.3. Click Download.

= The project configuration is transferred to the safety module.

3.4. After the successful transfer, click Done.

Home page, CRC safety configuration:

Document the checksum of the safety functions in the machine documentation.
Repeat the steps for each additional safety module in your project.
Exit PASmotion Safety Configurator.

Transfer of the configuration is completed.

Information

If you do not know the password for the configuration on the safety module and would like to send a new safety

configuration, you can delete the safety configuration on the safety module in DriveControlSuite using parameter S33.
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51.7.2 Saving the configuration

v" You have successfully transferred the configuration.

1. Online functions window, Online tab, Actions for drive controller in online operation area:
Click Save values (AQO).

= The Save values (A0OO) window opens.
2. Select on which drive controllers you want to save the configuration.

3. Click Start action.
= The configuration is stored on the drive controllers in non-volatile memory.

4. Close the Save values (A00) window.

Information

For the configuration to take effect on the drive controller, a restart may be required in certain cases, such as after the
configuration is saved on the drive controller for the first time or when changes are made to the firmware or process data

mapping.

Restarting a drive controller

v" You have stored the configuration on the drive controller in non-volatile memory.

1. Online functions window, Online tab:
Click Restart (A09).

= The Restart (A09) window opens.
2. Select which of the connected drive controllers you want to restart.
3. Click Start action.

4. Confirm the safety note with OK.
= The Restart (A09) window closes.
The fieldbus communication and connection between DriveControlSuite and drive controllers are interrupted.

The selected drive controllers restart.
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51.8 Testing the configuration

After you have transferred the configuration to the drive controller, first check your projected axis model and the
parameterized electrical and mechanical data for plausibility before continuing with the parameterization.

Test the configuration with drive-based control. For controller-based operating modes, this step is optional.

You can test the configuration quickly and easily via DriveControlSuite or, as an alternative, directly via the operating unit of
the drive controller. For further information, refer to the corresponding manual of the drive controller.

Information

Make sure that the values of the control panel are compatible with your projected axis model in order to obtain useful test
results that you can use to optimize your configuration for the respective axis.

The scaling calculator is available under the Axis model wizard > Axis: Scaling to recalculate the values for the control panel
according to your projected axis model.

/\ WARNING!

Injury to persons and material damage due to axis movement!

When you activate the control panel, DriveControlSuite gives you sole control of the motions of the axis. If you are using a
controller, it no longer monitors the axis movements after the control panel is activated. The controller cannot intervene to
prevent collisions. The controller takes over control again when the control panel is deactivated, which can cause
unexpected axis movements.

= Do not switch to other windows when the control panel is active.
= Only use the control panel if you have visual contact with the axis.
= Make sure that no people or objects are within the travel range.

= For access via remote maintenance, there must be a communication link between you and a person on site with eye
contact to the axis.
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Testing the configuration using the jog control panel
v" There is an online connection between DriveControlSuite and the drive controller.
v’ You have successfully stored the configuration on the drive controller.

v" No safety function is active.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >

Wizard area.
2. Select the Jog control panel wizard.

3. Click Control panel on and then Enable.
= The axis is monitored via the active control panel.

4. Check the default values of the control panel and adjust them to your projected axis model if necessary.

5. To test the configuration of your projected axis for direction of motion, velocity, etc., move the axis gradually using

the Jog+, Jog-, Jog step+ and Jog step- buttons.
6. Use your test results to optimize your configuration as necessary.

7. To deactivate the control panel, click on Control panel off.

Information

Jog+ and Jog- cause a continual manual movement in the positive or negative direction. Jog step+ and Jog step- move the
axis relative to the current actual position by the increment specified in 114.

Jog+ and Jog- have a higher priority than Jog step+ and Jog step-.
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5.2 TwinCAT 3: Putting the EtherCAT system into operation

TwinCAT 3 automation software gives you the option to map the hardware environment of your EtherCAT system and to
configure and parameterize all necessary bus parameters including data exchange via MainDevice and SubDevices (also see
TwinCAT 3 program interface [P 15]).

Note that all system nodes have to be networked physically before commissioning. In addition, you have projected the
drive controllers in question in advance, i.e. EtherCAT SubDevices in DriveControlSuite, and transmitted the configuration to
those drive controllers.

Information

For the following description, we require that you have projected the CiA 402 application.

Information

Always perform the steps described below in the specified order!

Some parameters are interdependent and do not become accessible to you until you have first configured certain settings.
Follow the steps in the specified sequence so that you can finish the parameterization completely.

5.21 EtherCAT MainDevice: Activating Config-Modus

To be able to configure the EtherCAT MainDevice online, first create a TwinCAT project, add a connection between TwinCAT
System Manager and EtherCAT MainDevice if necessary and activate Config mode.

Creating a TwinCAT project

v" You have saved the ESI file generated from the DriveControlSuite in the specified directory (C:
\TwinCAT\3.1\Config\IO\EtherCAT).

1. Start TwinCAT 3 Engineering.
= TwinCAT 3 Engineering opens; the Start Page tab is active.

= The stored ESl file is read in upon program start.
2. Select File > New > Project....
= The New Project window opens.

3. Select Installed > Templates > TwinCAT Projects > TwinCAT XAE Project (XML format).

4, Name, Location, Solution name:

Label the project and enter a save location and an internal project name.

5. Confirm with OK.
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EtherCAT MainDevice: Adding routing

If Run-Time (EtherCAT MainDevice) is installed on a different PC than TwinCAT System Manager, first establish a connection
by adding a route to the EtherCAT MainDevice.

v

The EtherCAT MainDevice is connected to the network, all system components are energized and the infrastructure is
ready for operation.

In TwinCAT 3 Engineering, click on the <Local> list field in the toolbar and select Choose Target System....
= The Choose Target System window opens.

Click on Search (Ethernet)....

= The Add Route Dialog window opens.

Click on Broadcast Search.

= The Select Adapter(s) window opens.

Select the adapter that is connected to your EtherCAT MainDevice and confirm with OK.

= All available controllers are listed.

Select the desired EtherCAT MainDevice and confirm with Add Route.

= The Add Remote Route window opens.

Under Remote User Credentials, enter the following data:
User name: Administrator

Password: 1

Confirm with OK.
= The connection to the EtherCAT MainDevice is added.

= The EtherCAT MainDevice is available as a target system for Config mode.

Close the Add Route Dialog and Choose Target System windows.

EtherCAT MainDevice: Activating Config-Modus

If necessary, select the EtherCAT MainDevice as the target system and activate Config mode so you can configure the

EtherCAT system online.

v

The EtherCAT MainDevice is connected to the network, all system components are energized and the infrastructure is
ready for operation.

You have added the routing to the EtherCAT MainDevice, if necessary.

If Run-Time (EtherCAT MainDevice) and TwinCAT System Manager are installed on different PCs, click on the <Local>
list field in the TwinCAT 3 Engineering toolbar and select the desired EtherCAT MainDevice.

= The EtherCAT MainDevice is saved as the target system.

To activate the configuration mode (Config Mode), select Menu TWINCAT > Restart TwinCAT (Config Mode).
= The Restart TwinCAT System in Config Mode dialog box opens.

Confirm with OK.

TwinCAT 3 Engineering is in Config mode for the selected EtherCAT MainDevice.
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522 Scanning the hardware environment

If all system components are connected to the EtherCAT network and the network is energized, it is possible to scan for

connected devices automatically. In this scenario, TwinCAT 3 Engineering searches for connected devices and terminals and

integrates them into the existing project in accordance with their configuration entries in the accompanying ESl files.

If the actual EtherCAT infrastructure is not available, i.e. you are configuring in offline mode, you must map and project all

connected devices manually in TwinCAT 3 Engineering. You can find more detailed information on this in the online help

tool of the TwinCAT 3 Engineering software.

v" You have activated Config mode.

1.

2.

In the solution explorer, navigate to 1/O > Devices > Scan context menu.

Confirm the HINT: Not all types of devices can be found automatically dialog box with OK.

= TwinCAT 3 Engineering scans the EtherCAT system for the EtherCAT MainDevice.

= The ... new I/0 devices found dialog box opens.

Activate the relevant EtherCAT MainDevice and confirm with OK.

= The EtherCAT MainDevice is created in the solution explorer under |/O > Devices as a device (EtherCAT).
= The Scan for boxes? dialog box opens.

Confirm with Yes.

= TwinCAT 3 Engineering scans the EtherCAT system for the EtherCAT SubDevices.

= The EtherCAT drive(s) added dialog box opens.

Append linked axis to:
If you are using controller-based operation for the drive controller, select the desired option and confirm with OK in

order to activate the NC or CNC function. For drive-based control, you prevent the creation of an axis using Cancel.

= The EtherCAT SubDevices are created in the solution explorer.
The Activate Free Run dialog box opens.

In order to shift the system components during configuration into free run mode and thereby enable verification of

the signal exchange, confirm with Yes.

EtherCAT MainDevice and SubDevices are created in TwinCAT 3 Engineering.
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523 Expanding the startup list

With the help of the startup list, you can change the values of objects during startup of the EtherCAT state machine via the
CoE protocol. You can add objects from the object directory of the ESI file to the startup list. If you are using the SDO Info
service, additional objects are also available. The objects are accessed in the order in which they appear in the startup list.

Information

Using the SDO Info service, the EtherCAT controller can read out the objects from the drive controller. You can define which
objects are transmitted using the service in DriveControlSuite using parameter A268. The service is only supported if you
have selected the EtherCAT Rx SDO Info template when creating the project in DriveControlSuite. For more information on
SDO Info, refer to the manual for communication with EtherCAT.

Selecting and adding an object from the list

Objects that are either contained in the object directory of the ESI file or have previously been read from the drive
controller via SDO Info are available for selection from a list in TwinCAT 3 Engineering.

v" EtherCAT MainDevice and SubDevices are created in TwinCAT 3 Engineering.
1. Inthe solution explorer, navigate to the EtherCAT SubDevice for which you want to add an object to the startup list.
2. Double-click on the EtherCAT SubDevice.
= The settings open in the main window.
3. Inthe main window, switch to the Startup tab.
= The current startup list is displayed.

4. Click New....
= The Edit CANopen Startup Entry window opens.

= All available objects are listed.

5. Inthe list, double-click on the object that you want to add to the startup list.

= The Set Value Dialog window opens.

6. Dec, Hex, Enum:
Enter the value to be written to the object in the field corresponding to the desired data format (decimal specification,

hexadecimal specification or selection from list).
7. Confirm the value with OK.

8. Transition:

In the Edit CANopen Startup Entry window, activate the state change upon which the object is to be written:
8.1. |->P: State change from Init to Pre-Operational

8.2. P ->S: State change from Pre-Operational to Safe-Operational

8.3. S->0: State change from Safe-Operational to Operational

8.4. 0O ->S: State change from Operational to Safe-Operational

8.5. S->P:State change from Safe-Operational to Pre-Operational

9. Comment:

If required, store a comment that will be displayed in the startup list for the object.
10. Confirm with OK.

= The object is added to the startup list.
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Adding an object via index and subindex
Alternatively, you can add objects to the startup list by their index and subindex.

For manufacturer-specific parameters, calculate the index and subindex of the object from the parameter coordinate in
advance (see Manufacturer-specific parameters: 2000 hex — 53FF hex [P 143]).

v' EtherCAT MainDevice and SubDevices are created in TwinCAT 3 Engineering.
1. Inthe solution explorer, navigate to the EtherCAT SubDevice for which you want to add an object to the startup list.
2. Double-click on the EtherCAT SubDevice.

= The settings open in the main window.

3. Inthe main window, switch to the Startup tab.

= The current startup list is displayed.

4, Click New....

= The Edit CANopen Startup Entry window opens.

5. Transition:

Activate the state change upon which the object is to be written:
5.1. |->P: State change from Init to Pre-Operational
5.2. P ->S:State change from Pre-Operational to Safe-Operational
5.3. S->0: State change from Safe-Operational to Operational
5.4. 0O ->S: State change from Operational to Safe-Operational
5.5. S ->P: State change from Safe-Operational to Pre-Operational

6. Index (hex):

Enter the index of the object (hexadecimal specification).

7. Sub-index (dec):

Enter the subindex of the object (decimal specification).

8. Data (hexbin):

Enter the value to be written to the object.

9. Comment:

If required, store a comment that will be displayed in the startup list for the object.
10. Confirm with OK.

= The object is added to the startup list.
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524 Configuring synchronization using distributed clocks

As the more precise of the two sync methods, synchronization using distributed clocks (DC-Sync) is pre-configured in the
EtherCAT SubDevices. Check the associated settings for EtherCAT MainDevice and SubDevices.

v" You have fully configured the associated axis model in the DriveControlSuite.

1. Navigate to the EtherCAT MainDevice in the solution explorer.

2. Double-click on the EtherCAT MainDevice.
= The settings open in the main window.

3. Inthe main window, switch to the EtherCAT tab and click Advanced Settings....
= The Advanced Settings window opens.

4. Inthe tree view, select Distributed Clocks.

5. Automatic DC Mode Selection:
This option must be activated.

6. Close the window.

7. Navigate to the first EtherCAT SubDevice in the solution explorer.

8. Inthe main window, switch to the DC tab and click Advanced Settings....
= The Advanced Settings window opens.

9. Enable:
This option must be activated.

10. DCenabled (multiplier = 1):
This list entry must be selected.

11. Sync Unit Cycle (ps):
Check the default value for the cycle time of the controller and change it if necessary.

12. Enable SYNCO0:
This option must be activated.

13. Close the window.

14. Repeat steps 7 — 13 for each additional SubDevice in your EtherCAT network.

= The EtherCAT MainDevice and SubDevices will now be synchronized with the first EtherCAT SubDevice that has the
distributed clocks option enabled.

525 Configuring synchronization via SyncManager event

Synchronization using distributed clocks (DC-Sync) is pre-configured in the EtherCAT SubDevices. You have the option of

switching the synchronization for one or more EtherCAT SubDevices manually to synchronization via SyncManager event
(SM-Sync).

1.

In the solution explorer, navigate to the EtherCAT SubDevice for which you want to change the synchronization to SM-

Sync.

Double-click on the EtherCAT SubDevice.
= The settings open in the main window.
In the main window, switch to the DC tab.

Operation Mode:

Select the SM Synchronous list entry from the picklist.

= You have changed the synchronization for the EtherCAT SubDevice.

Repeat the steps for each additional SubDevice of your EtherCAT network for which you want to switch the

synchronization to SM-Sync.
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5.2.6 CiA 402: Controller-based axis control

In order to control one or more drive controllers with controller-based operation when using the CiA 402 application

(incremental version), start by parameterizing the axes and then program your control.

5.2.6.1 Parameterizing an axis
1. Inthe solution explorer, navigate to Motion > NC-Task 1 SAF > Axes > Axis 1.
2. Double-click the axis.
= The settings open in the main window.
3. Inthe main window, switch to the Settings tab.
4. Unit:
Select degrees (°) as the unit.
5. Switch to the Parameters tab.
6. Open the Maximum Dynamics parameter list.
7. Parameterize associated limit values for velocity, acceleration and deceleration.
8. Open the Limit Switches parameter list.
9. Soft Position Limit Minimum Monitoring:
If you want to put a lower negative limit on position values, select the True list entry and enter the associated value in
Minimum Position.
10. Soft Position Limit Maximum Monitoring:
If you want to put an upper positive limit on position values, select the True list entry and enter the associated value in
Maximum Position.
11. Inthe solution explorer, navigate to Axis > Enc.
12. Inthe main window, switch to the Parameters tab.
13. Open the Encoder Evaluation parameter list.
14. Scaling Factor Numerator:
Specify the value 0.000343322 (360 + 1048576) — in accordance with the parameterization of A585[0] =
1048576 inc for the feed factor in DriveControlSuite.
15. Repeat the steps for each additional axis.
= The axes are parameterized.
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You can program control of the axes in TwinCAT 3 using the MC_POWER block.

6.2

Programming axis control

In order to control the drive controller with controller-based operation, the following operating modes are available in

parameter A541 Modes of operation:

For more information on the operating modes, see Operating modes in detail [» 108].

-1:Jog

6: Homing mode

7: Interpolated position mode or

8: Cyclic synchronous position mode
9: Cyclic synchronous velocity mode

10: Cyclic synchronous torque mode

The axes are controlled using control word A515. The device state machine has to receive certain commands for starting

operation and the associated state transitions. These commands are the result of a bit combination in the control word. The

order of the commands is specified by the device state machine in accordance with CiA 402.

For more information on device control, see CiA 402 device control [» 101].

In addition, the set values and actual values are available in the standard mapping; see EtherCAT and CiA 402 standard

mapping [» 136].

Gravity-loaded axis with brake

Information

If you are using a gravity-loaded axis and a brake, always use a quick stop to switch the drive (state transition 11 in
accordance with the device state machine). This prevents the load from dropping until the brake is fully engaged.

In the MC_POWER block, start by deactivating the Enable_Positive and Enable_Negative bits and then the Enable bit on a

delay in order to bring the drive to a standstill as defined.
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5.2.7 CiA 402 HiRes Motion: Drive-based axis control

Drive-based axis control in the CiA 402 HiRes Motion application requires manual programming in the automation software.
The following operating modes are available to you in the parameter A541 Modes of operation:

= -1:Jog

= 1: Profile position mode
= 2:Velocity mode

= 3: Profile velocity mode
= 4: Profile torque mode
= 6: Homing mode

For more information on the operating modes, see Operating modes in detail [» 108].

The axes are controlled using control word A515. The device state machine has to receive certain commands for starting
operation and the associated state transitions. These commands are the result of a bit combination in the control word; the
order of commands is specified by the device state machine in accordance with CiA 402.

For more information on device control, see CiA 402 device control [P 101].

In addition, the set values and actual values are available in the standard mapping; see EtherCAT and CiA 402 standard

mapping [» 136].

Gravity-loaded axis with brake

Information

If you are using a gravity-loaded axis and a brake, always use a quick stop to switch the drive (state transition 11 in
accordance with the device state machine). This prevents the load from dropping until the brake is fully engaged.
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5.2.8 Configuring EoE communication
1. Navigate to the EtherCAT MainDevice in the solution explorer.
2. Double-click on the EtherCAT MainDevice.
= The settings open in the main window.
3. Inthe main window, switch to the EtherCAT tab and click Advanced Settings....
= The Advanced Settings window opens.
4. Select EoE Support from the tree view on the left.
5. Virtual Ethernet Switch > Enable:
This option must be activated.
6. Close the window.
7. Navigate to the first EtherCAT SubDevice in the solution explorer.
8. Inthe main window, switch to the EtherCAT tab and click Advanced Settings....
= The Advanced Settings window opens.
9. Inthe tree view on the left, navigate to Mailbox > EoE.
10. Virtual Ethernet Port:
This option must be activated.
11. I[P Port:
Activate this option.
12. Define the type of address assignment:
12.1. Activate the DHCP option if an IP address is to be assigned to the EtherCAT SubDevice automatically via DHCP.
12.2. Activate the IP Address option in order to assign a fixed IP address to the EtherCAT SubDevice in accordance
with the subnet of your EoE device group. When assigning a fixed IP address for EoE, note that the first and last
host address in a subnet must not be used. If one of these addresses is configured in TwinCAT 3, it is not
accepted by the drive controller.
13. Default gateway:
When assigning a fixed IP address, the IP address of the EtherCAT network interface of the EtherCAT MainDevice must
be specified as the default gateway.
14. Close the window.
15. Repeat steps 7 — 14 for each additional SubDevice in your EtherCAT system.
= EoE communication is enabled for EtherCAT MainDevice and SubDevices.

Information

Depending on your EoE network structure, you may have to set the routing on your EtherCAT MainDevice PC manually to

connect the Ethernet and EtherCAT networks. For more information on the different use cases, refer to the manual for

communication with EtherCAT.
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Information

Address assignment via DHCP is possible via either a DHCP server or DriveControlSuite. This requires the DHCP server or
DriveControlSuite to be installed directly on the controller PC. Furthermore, the IP address reference must be correctly
defined in the drive controller (A166 = 2: DHCP + DS6, default value).

The correct assignment of the drive controllers in DriveControlSuite is ensured for TwinCAT 3 by the STOBER_BoxName
function block.

For more information on the topology and function blocks, refer to the manual for communication with EtherCAT.

5.2.9 Configuring a Station Alias

You have the option of assigning an EtherCAT Station Alias to each EtherCAT SubDevice. This address is stored in the
EEPROM of the respective drive controller. The drive controller can thus be connected to any open port within the network
and identified using the Station Alias.

1. Inthe solution explorer, navigate to the EtherCAT SubDevice to which you want to assign a Station Alias.

2. Double-click on the EtherCAT SubDevice.
= The settings open in the main window.

3. Inthe main window, switch to the EtherCAT tab and click Advanced Settings....

= The Advanced Settings window opens.

4. Inthe tree view on the left of the Advanced Settings window, navigate to ESC Access > E2PROM > Configured Station:
New Value: Enter the value you want to write as the Station Alias into the EEPROM.

5. Click Write to E2PROM to write the value to EEPROM.

6. Confirm the Function succeeded! dialog box with OK.

7. Close the Advanced Settings window with OK.

8. Repeat the steps for each additional SubDevice in your EtherCAT system to which you want to assign a Station Alias.
The configuration of the Station Alias is complete.

The change of addresses will take effect upon the next start of TwinCAT 3.

Information

In DriveControlSuite, the Station Alias can be read out via parameter A254.

5.210 Transmitting the configuration
Transfer the configuration to the EtherCAT MainDevice.
1. Select the menu TWINCAT > Activate Configuration.

2. Confirm the transfer of the project configuration to the EtherCAT MainDevice with OK.

= The Restart TwinCAT System in Run Mode dialog box opens.
3.  Confirm with OK.

= The configuration was transferred to the EtherCAT MainDevice.
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521 Checking the functionality of the axes

If you use controller-based operation for the drive controller, check the functionality of the axes before operation in
production.

Information

Ensure that a suitable safety application that ensures safe shut-off of the axis (emergency off, safety switch, etc.) exists
before the start of testing.

Information

In order to be able to check the function of the axes, the A541 Modes of operation parameter of the respective axis must
be set to the value 8 (default value).

1. Inthe solution explorer, navigate to Motion > NC-Task 1 SAF > Axes > Axis 1.
2. Double-click the axis.
= The settings open in the main window.
3. Inthe main window, switch to the Online tab.
4. Inthe Enabling area, click Set.
= The Set Enabling window opens.
5. Enable the Controller, Feed Fw and Feed Bw options.

6. Override:
Specify a value for the override (e.g. 100).

7. Confirm with OK.
= The axis is monitored via the active control panel.

8. F1-F4:
Move the axis step-by-step and test the movement direction, velocity, etc. using the corresponding buttons.

9. To deactivate the enable signal, click on Set Enabling and deactivate the options Controller, Feed Fw, Feed Bw.

10. Repeat the steps for each additional axis of your system.
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53 CODESYS Development System: Commissioning the
EtherCAT system

The CODESYS Development System is automation software that gives you the option to map the hardware environment of
your EtherCAT system and to configure and parameterize all necessary bus parameters including data exchange via
MainDevice and SubDevices.

Note that all system nodes have to be networked physically before commissioning. In addition, you have projected the
drive controllers in question in advance, i.e. EtherCAT SubDevices in DriveControlSuite, and transmitted the configuration to
those drive controllers.

Information

For the following description, we require that you have projected the CiA 402 HiRes Motion application.

Information

Always perform the steps described below in the specified order!

Some parameters are interdependent and do not become accessible to you until you have first configured certain settings.
Follow the steps in the specified sequence so that you can finish the parameterization completely.

5.31 Creating a standard project
1. Start the CODESYS Development System automation software.
2. Select Basic Operations > New Project.
= The New Project window opens.

3. Select a standard project that corresponds to your hardware version. Give it a name and save it wherever you want.

53.2 Adding a drive controller
1. Inthe device tree, navigate to the module EtherCAT_MainDevice (EtherCAT MainDevice) > Context menu Add Device.
= The Add Device window opens.

2. Device area > Vendor:
Select STOBER Antriebstechnik GmbH + Co. KG — Drives and open the folder with the same name.

= All drive controllers that can be mapped are displayed.
3. Highlight the desired drive controller in the SoftMotion_HiRes version and confirm with Add Device.
4. Repeat step 3 for all other drive controllers in your EtherCAT system.

= The selected drive controllers are added in the device tree under the EtherCAT_MainDevice (EtherCAT MainDevice)
controller.
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533

Configuring synchronization using distributed clocks

v" As the more precise of the two sync methods, synchronization using distributed clocks (DC-Sync) is pre-configured in

10.

the EtherCAT SubDevices.

In order to reduce jitter in general, we recommend setting data transfer (I/O) of the controller to task start in the

EtherCAT configuration.

In the device tree, navigate to the EtherCAT_MainDevice (EtherCAT MainDevice) module and double-click to open it.

= EtherCAT_MainDevice tab > General opens in the editor window.

Distributed Clock area > Cycle Time and Sync Offset:

Check the default values and change them if necessary.
To set the data transfer to task start, select Tools > Options > Device editor.
Activate the Show generic configuration editors option and confirm with OK.

Switch to the EtherCAT parameters vertical tab.

Navigate to the FrameAtTaskStart parameter and set the Value of the parameter to True.

= From now on, controller data transfer will take place at the start of the task.
In the device tree, double-click the first of the added drive controllers.
= SD6_SoftMotion_HiRes tab > General opens in the editor window.

Distributed Clocks area > Select DC:

DC enabled (multiplier = 1) and Sync 0 as a sync event are enabled by default.

If you want to change the presets, enable the Additional > Enable Expert Settings option and change the settings.

Repeat steps 7 — 9 for each additional drive controller in your EtherCAT network.

The EtherCAT MainDevice and SubDevices will now be synchronized with the first EtherCAT SubDevice that has the

distributed clocks option enabled.
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53.4 CiA 402: Controller-based axis control

In order to control one or more drive controllers with controller-based operation when using the CiA 402 application
(incremental version), start by parameterizing the axes and then program your control.

53.41 Parameterizing a SoftMotion axis

v" You have selected the CiA 402 HiRes Motion application and fully configured the associated axis model in
DriveControlSuite.

1. Inthe device tree, navigate to the first SoftMotion axis SM_Drive_EtherCAT_STOEBER_SD6_HiRes of the first of the

added SD6 drive controllers and double click to open it.

= SM_Drive_ETC_STOEBER_SD6_HiRes tab > General opens in the editor window.

2. Axis type and limits area > Modulo/Finite:

Activate your drive according to the listed options and parameterize the conditions necessary in each case:
2.1. Conditions for Modulo > Modulo settings: Define the modulo range by entering the associated modulo value.

2.2. Conditions for Finite > Software limit switches: If you want to put a lower negative limit or upper positive limit

on position values, enable the option and enter the associated values.

3. Software error reaction:
Delay: If braking is to be done on a delay, enter the associated value.
Maximum distance: Parameterize a maximum distance within which the drive must have reached a stop after an error
has occurred.
Set value monitoring of the drive controller is activated by default in the CiA 402 and CiA 402 HiRes Motion
applications. In order to prevent the drive controller from transitioning into the excessive set value jump state,

parameterize ramp that can realistically be implemented.

4. Dynamic limits (optional):
If you are using CNC or robotic functions, parameterize the associated limit values for velocity, acceleration,

deceleration and jerk.

5. Velocity ramp type (optional):
Using the velocity ramp type, define the velocity profile for movement-generating single axis modules and for

MainDevice/SubDevice modules. Select the appropriate profile.

6. Position lag supervision (optional):
Use the associated picklist to define the response of the controller when a following error is detected.
Lag limit: A following error is detected if the difference between the set position and actual position exceeds the lag

limit. If you have enabled position lag supervision by selecting a response, specify the associated value.
7. Switch to the Scaling/Mapping vertical tab.

8. Scaling area > Precision (decimal places):
Specify the parameterized number of decimal places in DriveControlSuite (106 Decimal places position) for specifying

and displaying positions, velocity values and acceleration values.
9. Repeat the steps for each additional SoftMotion axis in your EtherCAT system.

= The SoftMotion axes are parameterized.
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53.4.2 Programming axis control

You program the control of the axes in the automation software. See the CODESYS V3 documentation for the required
information.

In order to control the drive controller with controller-based operation, the following operating modes are available in
parameter A541 Modes of operation:

= -1:Jog

= 6: Homing mode

= 7:Interpolated position mode or

= 8: Cyclic synchronous position mode
= 9: Cyclic synchronous velocity mode
= 10: Cyclic synchronous torque mode

For more information on the operating modes, see Operating modes in detail [» 108].

The axes are controlled using control word A515. The device state machine has to receive certain commands for starting
operation and the associated state transitions. These commands are the result of a bit combination in the control word. The
order of the commands is specified by the device state machine in accordance with CiA 402.

For more information on device control, see CiA 402 device control [» 101].

In addition, the set values and actual values are available in the standard mapping; see EtherCAT and CiA 402 standard

mapping [» 136].

Gravity-loaded axis with brake

Information

If you are using a gravity-loaded axis and a brake, always use a quick stop to switch the drive (state transition 11 in
accordance with the device state machine). This prevents the load from dropping until the brake is fully engaged.

For information on how to switch off the drive via a quick stop, refer to the CODESYS V3 documentation.
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5.3.5 CiA 402 HiRes Motion: Drive-based axis control

Drive-based axis control in the CiA 402 HiRes Motion application requires manual programming in the automation software.
The following operating modes are available to you in the parameter A541 Modes of operation:

= -1:Jog

= 1: Profile position mode
= 2:Velocity mode

= 3: Profile velocity mode
= 4: Profile torque mode
= 6: Homing mode

For more information on the operating modes, see Operating modes in detail [» 108].

The axes are controlled using control word A515. The device state machine has to receive certain commands for starting
operation and the associated state transitions. These commands are the result of a bit combination in the control word; the
order of commands is specified by the device state machine in accordance with CiA 402.

For more information on device control, see CiA 402 device control [P 101].

In addition, the set values and actual values are available in the standard mapping; see EtherCAT and CiA 402 standard

mapping [» 136].

Gravity-loaded axis with brake

Information

If you are using a gravity-loaded axis and a brake, always use a quick stop to switch the drive (state transition 11 in
accordance with the device state machine). This prevents the load from dropping until the brake is fully engaged.

53.6 Configuring EoE communication

STOBER 6th generation drive controllers support EOE communication. For information on whether your controller also
supports EoE and how the packets are transferred from your controller to the service PC, refer to the documentation for
your controller.

Information

Depending on your EoE network structure, you may have to set the routing on your EtherCAT MainDevice PC manually to
connect the Ethernet and EtherCAT networks. For more information on the different use cases, refer to the manual for
communication with EtherCAT.

537 Transmitting the configuration

Transmit the project to your CODESYS SoftMotion controller and start CODESYS V3.
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5.3.8 Checking the functionality of the axes

If you use controller-based operation for the drive controller, check the functionality of the axes before operation in

production.

Information

Ensure that a suitable safety application that ensures safe shut-off of the axis (emergency off, safety switch, etc.) exists

before the start of testing.

5.3.9 Special case: Adding to the PDO transmission

v

Are you working with a controller-based operating mode (SoftMotion) and need expanded PDO transmission?
Proceed as described in the following steps. Note that you can transmit a maximum of 6 CiA objects or drive controller
parameters per channel.

In the device tree, navigate to the drive controller whose PDO transmission you would like to expand and double-click
to openiit.
= SD6_SoftMotion_HiRes tab > General opens in the editor window.

Additional area > Enable Expert Settings:

Activate this option.
Switch to the Expert Process Data Mode vertical tab.

PDO list:
The list contains one transmit and one receive channel for each parameterized SoftMotion axis.
Highlight the channel whose PDO transmission you would like to expand.

= PDO Content: This area shows all PDOs that are exchanged between the controller and drive controller over the
selected channel.

Click on Insert.

= The Select Item from Object Directory dialog box opens. The directory contains a selection of available CiA objects
(along with the coordinates and the name of the corresponding drive controller parameter from STOBER).

Highlight the CiA object for which you would like to extend PDO transmission and confirm with OK.
If the desired CiA object is not included in the directory, enter its index and subindex in the corresponding fields. For
manufacturer-specific parameters, calculate the two indices from the parameter coordinate in advance (see

Manufacturer-specific parameters: 2000 hex — 53FF hex [P 143]). Also select the data type that matches the data type

of the drive controller parameter and confirm with OK.

= The selected CiA object or the specified drive controller parameter has been added to the PDO content of the
selected channel.

Repeat steps 5 — 6 for all other CiA objects for which you would like to extend PDO transmission for the selected
channel.

If you would like to transmit more than 6 CiA objects or drive controller parameters per channel, add a transmit or
receive channel to the PDO list.

PDO list:

Click on Add.

= The Edit PDO list dialog box opens.

Name:

Name the new channel.
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10.

11.

12.

13.

14.

Index:

Specify the corresponding index depending on whether it is a transmit or receive channel.

Direction:
Activate the corresponding direction option (Note: TxPDO — sending direction = drive controller -> controller; RxPDO —

sending direction = controller -> drive controller).

SyncUnit:
If you have activated the sending direction of controller -> drive controller, enter 2.

If you have activated the sending direction of drive controller -> controller, enter 3.
Confirm with OK.

Switch to the associated DriveControlSuite project and add to the PDO transmission there in the same way as the
additions in CODESYS V3 (see Configuring PDO transmission [P 33]).

The expansion of PDO transmission takes effect the next time the EtherCAT MainDevice is started.
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§) More about CiA 4027

The following chapters summarize the important terms and relationships concerning CiA 402.

6.1 CiA 402 - Concept

Using the controller-based operating modes of CiA 402, you can implement applications with synchronized, cyclic set value
specification by a motion controller. In addition, the drive controllers can also independently handle motion tasks such as
referencing and jogging during commissioning.

The drive-based operating modes of CiA 402, on the other hand, offer complete movement calculation and design in the
drive. In this setup, the set values for position, velocity and torque/force are converted into movements accurately and
precisely. Referencing and jogging are performed, like all movements, with jerk limitation during commissioning. The drive
controllers are either networked over a fieldbus or obtain signals and set values using analog and digital hardware inputs.

The following graphic shows the components and configuration steps for the CiA 402 application. The elements shown in a
lighter shade are optional.

Fieldbus

Additional
function

Control Configuring the
panels motion profile

Calculating the
motion profile

Referencing
methods

Controlling the motor

Carrying out the
motion profile

o-H-H-H-

Fig. 5: Components and configuration steps

59



6 | More about CiA 402? STOBER

6.1.1 Activation

The application is based on the internationally standardized CiA 402 CANopen device profile for electric drives. Accordingly,
the drive control is controlled using CiA 402-compliant control and status words.

6.1.2 Operating modes

The CiA 402 application provides 3 controller-based operating modes in production operations. In these modes, the
controller handles the cyclical position, velocity or torque/force specification:

= 7: Interpolated position mode or 8: Cyclic synchronous position mode for position-controlled drives
= 9: Cyclic synchronous velocity mode for velocity-controlled drives
= 10: Cyclic synchronous torque mode for torque/force-controlled drives

In addition, 4 drive-based operating modes are available in production operations. For these modes, the drive calculates the
necessary motion profiles by itself:

= 1: Profile position mode for target position specification by a controller
= 2: Velocity mode for set velocity specification by a controller
= 3: Profile velocity mode for set velocity specification by a controller
= 4: Profile torque mode for set torque/force specification by a controller
Using the 6: Homing mode operating mode, you can reference the drive independently of the controller.

For commissioning, emergency operation and maintenance or repair work, the STOBER-specific -1: Jog operating mode
(manual movement) is available. Using this mode, you can move the drive independently of the controller.

For more information on the operating modes, see Operating modes in detail [» 108].

6.1.3 Data sources

The signals for controlling the drive controller, i.e. control signals for the start of motion, motion limits or set value
specifications, can be obtained from various external sources.

A fieldbus is usually acts as the signal source, but analog or digital hardware inputs, or even mixed operation made up of
the above-listed sources, can also be used to control the drive controller.

Values that are obtained from external data sources are usually adapted to the stored reference values automatically, i.e.
calibrated and calculated with scaling.

6.1.4 User-defined status word

In the user-defined status word, you have the option of defining the meaning of each individual bit yourself. You can
subsequently define a total of 16 sources in A66 that are to be exchanged between drive controller and controller and
about which you require information.

6.1.5 Additional functions

The additional Touch probe 1 and Touch probe 2 functions enable position measurement on a digital signal.

For more detailed information on how it works along with examples, see Touch probe — Examples [» 132].
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6.1.51 Additional fieldbus-controlled analog output function

In CiA 402 type applications, the additional fieldbus-controlled analog output function allows you to control the respective
analog output directly via a controller, e.g. for operating simple actuators such as pumps, fans, or valves. The additional
function can be used to specify an individual set value for each analog output (enable: G303; set value: G306, G309). When
fieldbus communication is active, the set value point is written by the controller via the process data mapping (G304,
G307). In addition, a fallback value can be defined which supplies the set value at the respective analog output if fieldbus
communication fails (G305, G308).

6.1.5.11 Parameterizing a fieldbus-controlled analogue output

To parameterize the additional function for controlling analog outputs via fieldbus, proceed as described below.

Information

To use the additional function for controlling the analog outputs via fieldbus, expand the process data mapping of the
application, depending on the fieldbus used. Further information on process data mapping can be found in the relevant
fieldbus manual.

Parameterizing fieldbus-controlled analogue output AO1

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >

Wizard area.
2. Select the CiA 402 application wizard > Additional functions.

3. Activate the Fieldbus-controlled analog output 1 option.
= The additional function is activated and the associated wizard is displayed.

4. Select the CiA 402 application wizard > Additional functions > Fieldbus-controlled analog output 1.

5. G305 Set value AO1 fallback:

Define the fallback value used to control the analog output if fieldbus communication fails.
6. Select the Terminals wizard > Analog output 1.

6.1. F40 AO1 source:

For set value specification via fieldbus, select parameter G306 as the source for analog output AO1.

6.2. F41 AO1 reference value source:

If necessary, delete the reference value of analog output AO1.

7. For fieldbus communication via EtherCAT, add parameter G304 to the receive process data RxPDO A225 — A228 and

create a new ESl file for the controller if necessary.
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Parameterizing fieldbus-controlled analogue output AO2

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the CiA 402 application wizard > Additional functions.
3. Activate the Fieldbus-controlled analog output 2 option.
= The additional function is activated and the associated wizard is displayed.
4. Select the CiA 402 application wizard > Additional functions > Fieldbus-controlled analog output 2.

5. G308 Set value AO2 fallback:

Define the fallback value used to control the analog output if fieldbus communication fails.
6. Select the Terminals wizard > Analog output 2.

6.1. F50 AO2 source:

For set value specification via fieldbus, select parameter G309 as the source for analog output AO2.

6.2. F51 AO2 reference value source:

If necessary, delete the reference value of analog output AO2.

7. For fieldbus communication via EtherCAT, add parameter G307 to the receive process data RxPDO A225 — A228 and

create a new ESl file for the controller if necessary.

6.1.6 Control panels

The control panels are special wizards in DriveControlSuite, which you can use to take control of the axis. With the help of
the control panels, you can manually release and move an axis even if the drive controller has no operating unit or is
difficult to access.

Using control panels, you can check the connection wiring, the project configuration of your physical axis model or the
parameterization of your application before you start commissioning the controller or switch to normal operation.

The following control panels are available:
= Jog control panel is used to check the projected axis model in jog mode.

= Control panel motion provides you with a standard set of motion commands based on PLCopen. Via the control panel,
independent of the application and fieldbus interface, you can parameterize a motion profile directly for the motion
core of the axis in order to check the basic functions of the drive controller.

For a comparison of operating modes in accordance with CiA 402 and the PLCopen commands, see Operating modes in
accordance with CiA 402 — Commands [» 125].

Because control panels override normal operation, they can be activated only with a deactivated enable signal and should
be operated by experienced users only.

6.1.7 Motion core

Based on the projected and parameterized data, the motion core calculates a motion profile and associated detail
movements as a basis for the drive controller as well as mandatory set values for the control cascade.
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6.2 Axis model

With the help of the axis model, you map the real mechanical environment of your drive project in DriveControlSuite by
parameterizing the axis type and the arrangement of existing encoders. The parameterization of the axis model is required
for the smooth operation and easy diagnosis of your drive train.

With 105 Type of axis, you select a rotational or a translational axis model and define whether the scaling of the axis is done
using either predefined or individually configured units of measure. With 100 Position range, you parameterize either an
endless (modulo) or a limited travel range. You parameterize the encoder arrangement by using B26 Motor encoder and
102 Position encoder.

The 6th generation of STOBER drive controllers are specially developed for communication between the drive controller
and controller on the basis of the actual variables at the output (° or mm of real axis movement). The scaling of the axis
model is calculated by the drive controller's firmware independently of the encoder model, without any rounding errors or
drift.

If your axis model is not followed by any other gear ratios, you can operate the axis with output-side motion variables
where all nominal and actual values correspond to the real axis movement.

Information

The firmware processes values for the motion variables velocity, acceleration and jerk in the data type REAL32 (floating-
point number, 32 bits). Position values are processed in the INT32 data type (integer, 32 bits) to eliminate rounding errors
and enable precise movements.

LinM Linear Motor

M Motor

MEnc Motor Encoder
PEnc Position Encoder

Rotational axis models

The following figures each show a rotational axis model consisting of a motor, a gearbox and a rotary table (endless
rotational) or a pointer (limited rotational). Rotational axis models support rotational motor encoders as well as rotational

N

position encoders.

ny
= M,

Gear

Fig. 6: Endless-rotational motion: Rotary table

I

ny
n,

Gear

Fig. 7: Limited-rotational motion: Pointer
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Translational axis models

The following figures each show a translational axis model consisting of a motor, gearbox, feed and conveyor belt (endless
translational) or tool slide (limited translational). Translational axis models support rotational motor encoders as well as
rotational or translational position encoders.

+—>
B L _1n
— — .
Gear Feed
Fig. 8: Endless translational motion: Conveyor belt
+—>
= =g m
| ] X

Gear Feed

Fig. 9: Limited translational motion: Tool slide

Translational axis model: Linear motor

The following figure shows a limited translation axis model using the example of a linear motor. Linear motors only support
translational motor encoders and translational position encoders.

+“—>
LinM
B |
cev v P g
MEnc/PEnc

Fig. 10: Limited translational motion: Linear motor
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Encoder arrangement

You parameterize the encoder arrangement by using B26 Motor encoder and 102 Position encoder. The motor encoder for
velocity control is located on the motor shaft. The position encoder for position control is located on the gearbox output. If

you use only one of the two encoders, it will be used for both velocity and position control.

Encoder Parameterization Encoder arrangement

(AR

Motor encoder

Position encoder

Motor encoder & position
encoder

B26 # 0: Inactive

102 = 0: Motor encoder

B26 # 0: Inactive

102 =B26

B26 # 0: Inactive

102 £ B26

MEnc

()=

Gear unit

n,
n,

Gear unit  PEnc

MEnc

Gear unit  PEnc
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6.3 Limit switches

With limit switches, you can secure the travel range by selecting the respective end of the travel range and thus limiting the
permitted positions of the axis. Hardware limit switches and software limit switches are available to limit the travel range.
Hardware and software limit switches can be used individually or in combination with each other.

Hardware limit switches are physical sensors (hardware) that are triggered when a certain position is reached, while
software limit switches are purely software-implemented functions for position limiting that are only available when the
travel range is limited (100 = O: Limited).

Function

When a limit switch is overshot, event 53: Limit switch is triggered and the axis goes into a fault condition with or without a
quick stop, depending on the parameterization. As soon as a limit switch is triggered, the motion core interrupts the current
motion command and refuses further commands in the same direction of motion. The direction lock ensures that the axis
can only move away from the limit switch in the opposite direction and return to the permitted travel range. As soon as the
direction lock is deactivated, event 53: Limit switch can be triggered again.

Further information on event 53: Limit switch, possible causes and actions can be found in the drive controller manual (see
Detailed information [P 145]).

ATTENTION!

Material damage due to leaving the permitted travel range

When a limit switch is overshot, the axis at the end of the permitted travel range will go into a fault condition, either with
or without a quick stop depending on the parameterization of the device control, so it may come to a standstill past the
limit switch and outside the permitted travel range.

= Allow sufficient space past the limit switch for your application to bring the axis to a standstill.

Restriction of the direction of motion

With an endless travel range, a direction lock can also be triggered by a positioning command outside the revolution length
or by restricting the direction of motion using 104 (travel range: 100 = 1: Endless; revolution length: 101; permitted direction:
104). A restriction of the direction of motion is also indicated in the operating state of the axis (operating state: E80Q).

Since restricting the direction of motion using 104 prevents the hardware limit switch from moving in the opposite direction
of motion, it is generally not advisable to combine the two functions.
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6.3.1 Hardware limit switches

Hardware limit switches can be used for both limited and endless travel ranges (travel range: 100). A digital input can serve
as the source for the digital signal for evaluating the respective hardware limit switch (source: 1101, 1102).

The digital signals for evaluating the hardware limit switches are low-active (normally closed contact), i.e. the limit switch is
triggered when the digital signal is interrupted (signal: 1441, 1442 = 0: Inactive). Ensure that the hardware limit switches are
connected correctly to prevent false triggering of event 53: Limit switch.

Relevant parameters
= |101 Source positive /limit switch
= ]102 Source negative /limit switch
= 1441 Signal /HW limit switch positive
= 1442 Signal /HW limit switch negative
= 1805 Actual value HW-Limit switch positive
= 1806 Actual value HW-Limit switch negative
= |52 Delete limit switch memory

= 1196 Direction blocking

Normal operation
When a hardware limit switch is overshot, event 53: Limit switch is triggered with a fault reaction.
Causes

= 1:Hardware-Limit-Switch positive (prerequisite: 1441 = 0: Inactive)

= 2:Hardware-Limit-Switch negative (prerequisite: 1442 = 0: Inactive)

A hardware limit switch is triggered when the digital signal for evaluating the hardware limit switches is interrupted. The
motion core interrupts the current motion command and refuses further commands in the same direction of motion; a
direction lock becomes active (denial: 191 = 1: Active; cause: 190; direction lock: 1196).

The direction lock is deactivated as soon as the limit switch memory is reset.

Jog mode

With hardware limit switches, the behavior of the axis is independent of the control type selected for jog mode (126). When
a hardware limit switch is overshot, the axis behaves the same way in jog mode as in normal operation.

Referencing

During referencing, hardware limit switches can be evaluated like reference switches by using the corresponding
referencing type (referencing type: 130 = 2: Limit switch; referencing methods: A, C, E, G).

With other referencing types, a triggered hardware limit switch reverses the direction of motion if the limit switch matches
the direction of motion (e.g. positive limit switch and positive direction of motion). If a triggered hardware limit switch does
not match the direction of motion, fault 53: Limit switch is triggered (e.g. positive limit switch with negative direction of
motion).

Example

At the start of referencing, the axis is between the reference switch and positive limit switch. The referencing direction is
positive. The axis moves in the positive direction and first encounters the positive limit switch, not the reference switch.
The axis reverses and searches for the reference switch in the other direction.
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Limit switch memory

When a hardware limit switch is overshot, the position of the limit switch is saved internally and the triggered limit switch is
recorded as active in the limit switch memory as long as the axis is at or past the limit switch (limit switch memory: 1805,
1806). Based on the stored position of the limit switch and the digital signals for evaluating the hardware limit switches, the
limit switch memory is automatically reset in normal operation as soon as the axis has returned to the permitted travel
range.

HW limit switch negative HW limit switch positive
: Permitted travel range
|
I
|

1442

1806

1441

1805

A
\

Position of the axis

1 3
- E—
2 4
— 47

Fig. 11: Hardware limit switch: Limit switch memory

1 Negative HW limit switch triggered, limit switch memory set
2 Negative HW limit switch exited, limit switch memory reset
3 Positive HW limit switch triggered, limit switch memory set
4

Positive HW limit switch exited, limit switch memory reset
Example

A positive hardware limit switch ranges from position 100 to 120; when moving in the positive direction of motion, it is
triggered at position 100 (signal: 1441 = 1: Active - 0: Inactive). On the return journey, the tolerance may cause the real
hardware limit switch to be left at position 101 (signal: 1441 = 0: Inactive - 1: Active). However, in order for the effective
limit switch or limit switch memory to be reset, position 100 must be reached or undershot.

The position of the limit switch is not stored in non-volatile memory, i.e. if the axis is outside the limit switches after
switching on, it must first be moved back into the permitted travel range.

During commissioning or in case of defective hardware limit switch connections, problems can arise with the saved
positions. These can be deleted with parameter 152. However, deletion only takes place if the corresponding limit switch
signal is inactive. Stored positions can also be deleted by referencing, setting a reference can be deleted using 1452 or by
restarting the drive controller.
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6.3.2 Software limit switches

Software limit switches are only available with a limited travel range (100 = 0: Limited). To be able to check the actual
position of the axis using software limit switches, the axis must be referenced.

The position of the negative software limit switch must be a smaller value than the position of the positive software limit
switch. If the same value is defined for both software limit switches, the function is deactivated.

Relevant parameters

= A570[0] Software position limit: Lowest permissible position

A570[1] Software position limit: Greatest permitted position
= |22 Target window

= |80 Current position

1196 Direction blocking

Normal operation
When a software limit switch is overshot, event 53: Limit switch is triggered with a fault reaction.
Causes

= 3: SW-limit switch positive (prerequisite: 180 > A570[1] + 122)

= 4: SW-limit switch negative (prerequisite: 180 < A570[0] + 122)

A software limit switch is triggered if the actual position of the axis is outside the permitted travel range, taking the position
window into account. The motion core interrupts the current motion command and refuses further commands in the same
direction of motion; a direction lock becomes active (denial: 191 = 1: Active; cause: 190; direction lock: 1196).

The direction lock is deactivated as soon as the actual position of the axis is back within the permitted travel range, taking
the position window into account.

Jog mode
With software limit switches, the behavior of the axis is independent of the control type selected for jog mode (126).

A quick stop is triggered instead of a fault reaction when a software limit switch is overshot in jog mode, so that the axis
comes to a standstill outside the permitted travel range depending on the quick stop deceleration (deceleration: 117). The
direction lock ensures that the axis can only move away from the limit switch in the opposite direction and return to the
permitted travel range.

Referencing

Software limit switches are not evaluated during referencing (motion command 1401 = 6: MC_Home).
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6.4 Referencing

To be able to work with a system with absolute positions, the relation of a measured axis position to an actual axis position
must be determined.

During initial commissioning or after changes to the axis model, the actual position of the axis is unknown. A defined initial
position is necessary. As a rule, this is either identified through a reference search or referencing setting. The associated
process is referred to as referencing.

Absolute movements can be performed only in a referenced state. For relative movements, referencing is only required if
the software limit switch function is used at the same time.

6.4.1 Referencing methods

The following table shows an overview of the possible referencing methods.

S Switch

M/F Torque or force

Method CiA 402 Homing Initial Zero pulse | Feature
method movement
1: Homing on negative Negative Negative limit switch
limit switch and index
pulse

B 5: Homing on Negative Yes Negatively positioned
negative home switch reference switch

and index pulse

C 17: Homing on Negative - Negative limit switch
negative limit switch

D 21: Homing on Negative - Negatively positioned

negative home switch reference switch
I i E 2: Homing on positive  Positive Yes Positive limit switch

limit switch and index
pulse

F 3: Homing on positive = Positive Yes Positively positioned
home switch and reference switch
index pulse

G 18: Homing on Positive - Positive limit switch

positive limit switch

H 19: Homing on Positive - Positively positioned
positive home switch reference switch

I '4 I | 7: Homing on home Positive Yes Centrally positioned
switch and index reference switch
pulse initial positive

J 23: Homing on home  Positive - Centrally positioned
switch initial positive reference switch
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Method CiA 402 Homing Initial Zero pulse | Feature
method movement

M/F —»

<«— M/F

Tab. 4: Referencing methods

]
g ¢
=

11: Homing on home  Negative
switch and index
pulse initial negative

27: Homing on home  Negative
switch initial negative

33: Homing onindex  Negative
pulse negative

34: Homing on index  Positive
pulse positive

37: Homing on -
current position (35:
Homing on current
position)

-1: Homing on Positive
torque/force limit

initial positive

-3: Homing on torque/ Positive
force limit and index

pulse initial positive

-2: Homing on Negative
torque/force limit

initial negative

-4: Homing on torque/ Negative
force limit and index

pulse initial negative

Yes

Yes

Yes

Yes

Centrally positioned
reference switch

Centrally positioned
reference switch

Setting the reference

Torque/force stop

Torque/force stop

Torque/force stop

Torque/force stop
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6.4.1.1 Referencing methods in detail
The following chapters show the individual referencing methods in detail.

The following abbreviations are used in the graphs on the referencing methods:

ALT Alternative

LS Limit Switch

RS Reference Switch

ZP Zero Pulse
Information

For graphically representing axes, the left is the smallest and the right is the largest position value. This means a positive
movement goes to the right and a negative to the left.

The following parameters are used in the descriptions of the referencing methods:

A569 Home offset

A586 Homing method

A587[0] Speed during search for switch
A587[1] Speed during search for zero
A588 Homing acceleration

128 Homing torque/force limit

129 Time homing torque/force limit
143 Move to reference position
144 Referencing jerk

153 Index search offset

1101 Source positive /limit switch
1102 Source negative /limit switch
1103 Source reference switch
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6.4.1.1.1 Referencing method A

Referencing method A determines a reference using a run to the negative limit switch and zero pulse.

This method corresponds to the CiA 402 Homing method, 1: Homing on negative limit switch and index pulse operating

LS- LS+

/

1

mode.

Preparation

1. Activate referencing method A by setting A586 to a value of 1: Homing on negative limit switch and index pulse.
2. 1102:
Enter the data source for the negative limit switch.
3. A587[0], A587[1], A588, 144, A569:
Define the set values necessary for referencing.
4. 153:
Define the start of the search for the zero pulse search.
Referencing

If the CiA 402 homing operating mode is active, referencing takes place as follows:

1.

2.

The drive starts in the negative direction with acceleration A588 and velocity A587[0].

It changes its direction upon reaching the negative limit switch and continues its run with velocity A587[1] until it

reaches the next zero pulse after leaving the limit switch.
The current actual position is set to the value of reference position A569 upon reaching the zero pulse.
The drive comes to a standstill with deceleration A588.

If 143 is set to 1: Active, the drive is positioned at reference position A569.
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6.4.1.1.2 Referencing method B

Referencing method B determines the reference using a run to the negatively positioned reference switch and zero pulse.

ALT 1

ALT 2

zp

RS

—

/

A

Y

N

This method corresponds to the CiA 402 Homing method, 5: Homing on negative home switch and index pulse operating

mode.

Preparation

1.

Activate referencing method B by setting parameter A586 to the value 5: Homing on negative home switch and index

pulse.

1103:

Enter the data source for the reference switch.
A587[0], A587[1], A588, 144, A569:

Define the set values necessary for referencing.

153:

Define the start of the search for the zero pulse search.

Referencing

If the CiA 402 homing operating mode is active, a distinction is made between two referencing variants.

v" Alternative 1: Drive has not actuated reference switch

1.

2.

The drive starts in the negative direction with acceleration A588 and velocity A587[0].

It changes its direction upon reaching the reference switch and continues its run with velocity A587[1] until it reaches

the next zero pulse after leaving the reference switch.

The current actual position is set to the value of reference position A569 upon reaching the zero pulse.
The drive comes to a standstill with deceleration A588.

If 143 is set to 1: Active, the drive is positioned at reference position A569.

Alternative 2: Drive stopped at reference switch

The drive starts in the positive direction with acceleration A588 and velocity A587[1].

It changes its direction upon reaching the reference switch and continues its run with velocity A587[0].

When the drive comes to a stop after the reference switch, it changes direction again and continues at velocity
A587[1] until it reaches the zero pulse.

The current actual position is set to the value of reference position A569 upon reaching the zero pulse.
The drive comes to a standstill with deceleration A588.

If 143 is set to 1: Active, the drive is positioned at reference position A569.
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6.411.3 Referencing method C

Referencing method C determines the reference using a run to the negative limit switch.

LS- LS+

o
| /
LS- |

This method corresponds to the CiA 402 Homing method, 17: Homing on negative limit switch operating mode.

1

Preparation

1. Activate referencing method C by setting parameter A586 to the value 17: Homing on negative limit switch.

2. 1102:

Enter the data source for the negative limit switch.

3. A587[0], A587[1], A588, 144, A569:

Define the set values necessary for referencing.

Referencing
If the CiA 402 homing operating mode is active, referencing takes place as follows:
1. The drive starts in the negative direction with acceleration A588 and velocity A587[0].

2. It changes its direction upon reaching the negative limit switch and continues its run with velocity A587[1] until it

leaves the limit switch again.
3. The current actual position is set to the value of the reference position A569 upon leaving the limit switch.
4. The drive comes to a standstill with deceleration A588.

5. If143is setto 1: Active, the drive is positioned at reference position A569.
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6.4.1.1.4 Referencing method D

Referencing method D determines the reference using a run to the negatively positioned reference switch.

s

w—
ALT1 VA |

N\ /

N
ALT 2 f \V

RS I

This method corresponds to the CiA 402 Homing method, 21: Homing on negative home switch operating mode.

Preparation
1. Activate referencing method D by setting parameter A586 to the value 21: Homing on negative home switch.

2. 1103:

Enter the data source for the reference switch.

3. A587[0], A587[1], A588, 144, A569:

Define the set values necessary for referencing.

Referencing

If the CiA 402 homing operating mode is active, a distinction is made between two referencing variants.
v' Alternative 1: Drive has not actuated reference switch
1. The drive starts in the negative direction with acceleration A588 and velocity A587[0].

2. It changes its direction upon reaching the reference switch and continues its run with velocity A587[1] until it leaves

the reference switch again.
3. The current actual position is set to the value of the reference position A569 upon leaving the reference switch.
4. The drive comes to a standstill with deceleration A588.

5. Ifl43isset to 1: Active, the drive is positioned at reference position A569.

v' Alternative 2: Drive stopped at reference switch

1. The drive starts with acceleration A588 and velocity A587[1] in the positive direction until it leaves the reference

switch.
2. It changes its direction upon leaving the reference switch and continues its run with velocity A587[0].

3.  When the drive comes to a stop after the reference switch, it changes direction and continues its run at velocity

A587[1] until it reaches the reference switch again.
4. The current actual position is set to the value of the reference position A569 upon reaching the reference switch.
5. The drive comes to a standstill with deceleration A588.

6. If143is set to 1: Active, the drive is positioned at reference position A569.
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6.4.1.1.5 Referencing method E

Referencing method E determines the reference using a run to the positive limit switch and zero pulse.

LS- LS+

-
/

Y

zp —1
L+ |

This method corresponds to the CiA 402 Homing method, 2: Homing on positive limit switch and index pulse operating

mode.

Preparation

1. Activate referencing method E by setting parameter A586 to the value 2: Homing on positive limit switch and index

pulse.

2. 1101:

Enter the data source for the positive limit switch.

3. A587[0], A587[1], A588, 144, A569:

Define the set values necessary for referencing.

4. 153:

Define the start of the search for the zero pulse search.

Referencing
If the CiA 402 homing operating mode is active, referencing takes place as follows:
1. The drive starts in the positive direction with acceleration A588 and velocity A587[0].

2. It changes its direction upon reaching the positive limit switch and continues its run with velocity A587[1] until it

reaches the next zero pulse after leaving the limit switch.
3. The current actual position is set to the value of reference position A569 upon reaching the zero pulse.
4. The drive comes to a standstill with deceleration A588.

5. If143is set to 1: Active, the drive is positioned at reference position A569.
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6.4.1.1.6 Referencing method F

Referencing method F determines the reference using a run to the positively positioned reference switch and zero pulse.

—

ALT 1 ./

ALT 2

A

A

P

A
S

RS

This method corresponds to the CiA 402 Homing method, 3: Homing on positive home switch and index pulse operating
mode.

Preparation

1. Activate referencing method F by setting parameter A586 to the value 3: Homing on positive home switch and index

pulse.

2. 1103:

Enter the data source for the reference switch.
3. A587[0], A587[1], A588, 144, A569: Define the set values necessary for referencing.

4. 153:

Define the start of the search for the zero pulse search.

Referencing

If the CiA 402 homing operating mode is active, a distinction is made between two referencing variants.
v' Alternative 1: Drive has not actuated reference switch
1. The drive starts in the positive direction with acceleration A588 and velocity A587[0].

2. It changes its direction upon reaching the reference switch and continues its run with velocity A587[1] until it reaches

the next zero pulse after leaving the reference switch.
3. The current actual position is set to the value of reference position A569 upon reaching the zero pulse.
4. The drive comes to a standstill with deceleration A588.

5. If143is set to 1: Active, the drive is positioned at reference position A569.

v’ Alternative 2: Drive stopped at reference switch
1. The drive starts in the negative direction with acceleration A588 and velocity A587[1].
2. It changes its direction upon reaching the reference switch and continues its run with velocity A587[0].

3.  When the drive comes to a stop after the reference switch, it changes direction again and continues at velocity
A587[1] until it reaches the zero pulse.

4. The current actual position is set to the value of reference position A569 upon reaching the zero pulse.
5. The drive comes to a standstill with deceleration A588.

6. If143is set to 1: Active, the drive is positioned at reference position A569.
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6.4.11.7 Referencing method G

Referencing method G determines the reference using a run to the positive limit switch.

LS- LS+

-
/

Y

{i/

LS+

This method corresponds to the CiA 402 Homing method, 18: Homing on positive limit switch operating mode.

Preparation
1. Activate referencing method G by setting parameter A586 to the value 18: Homing on positive limit switch.

2. 1102:
Enter the data source for the positive limit switch.

3. A587[0], A587[1], A588, 144, A569:

Define the set values necessary for referencing.

Referencing

If the CiA 402 homing operating mode is active, referencing takes place as follows:
1. The drive starts in the positive direction with acceleration A588 and velocity A587[0].

2. It changes its direction upon reaching the positive limit switch and continues its run with velocity A587[1] until it

leaves the limit switch again.
3. The current actual position is set to the value of the reference position A569 upon leaving the limit switch.
4. The drive comes to a standstill with deceleration A588.

5. If143is set to 1: Active, the drive is positioned at reference position A569.
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6.4.1.1.8 Referencing method H

Referencing method H determines the reference using a run to the positively positioned reference switch.

= ' = ]

ALT1 ¥ >

f X/
AN |
ALT 2 \ 4 A

|

RS

This method corresponds to the CiA 402 Homing method, 19: Homing on positive home switch operating mode.

Preparation
1. Activate referencing method H by setting parameter A586 to the value 19: Homing on positive home switch.

2. 1103:

Enter the data source for the reference switch.

3. A587[0], A587[1], A588, 144, A569:

Define the set values necessary for referencing.

Referencing

If the CiA 402 homing operating mode is active, a distinction is made between two referencing variants.
v' Alternative 1: Drive has not actuated reference switch
1. The drive starts in the positive direction with acceleration A588 and velocity A587[0].

2. It changes its direction upon reaching the reference switch and continues its run with velocity A587[1] until it leaves

the reference switch again.
3. The current actual position is set to the value of the reference position A569 upon reaching the reference switch.
4. The drive comes to a standstill with deceleration A588.

5. If143is setto 1: Active, the drive is positioned at reference position A569.

v' Alternative 2: Drive stopped at reference switch

1. The drive starts with acceleration A588 and velocity A587[1] in the negative direction until it leaves the reference

switch.
2. It changes its direction upon leaving the reference switch and continues its run with velocity A587[0].

3.  When the drive comes to a stop after the reference switch, it changes direction and continues its run at velocity

A587[1] until it reaches the reference switch again.
4. The current actual position is set to the value of the reference position A569 upon reaching the reference switch.
5. The drive comes to a standstill with deceleration A588.

6. If143is set to 1: Active, the drive is positioned at reference position A569.
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6.4.1.1.9 Referencing method |
Referencing method | determines the reference using a run to the centered reference switch and zero pulse.
LS- [ RS | LS+
- = =
i | ! :
b ! :
i : : i
ALT 1 . — : ,
1 1
ii s s
i : ! i
1 1 1
ALT2 ; VAN | i 5
| 1
L i i
o i !
! !
ALT 3 X i - i 1 |
o | o
Lo ! « :
! i i i
| i s L
ZP T T T
1 1 1
1 1 1
| I ’
RS :
LS+ |

L

This method corresponds to the CiA 402 Homing method, 7: Homing on home switch and index pulse initial positive

operating mode.

Preparation

1.

Activate referencing method | by setting parameter A586 to the value 7: Homing on home switch and index pulse

initial positive.

1103:
Enter the data source for the reference switch.

A587[0], A587[1], A588, 144, A569:
Define the set values necessary for referencing.

153:
Define the start of the search for the zero pulse search.

Referencing

If the

v

1.

2.

CiA 402 homing operating mode is active, a distinction is made between three referencing variants.
Alternative 1: Drive is positioned between the negative limit and reference switches
The drive starts in the positive direction with acceleration A588 and velocity A587[0].

It changes its direction upon reaching the reference switch and continues its run with velocity A587[1] until it reaches

the next zero pulse.
The current actual position is set to the value of reference position A569 upon reaching the zero pulse.
The drive comes to a standstill with deceleration A588.

If 143 is set to 1: Active, the drive is positioned at reference position A569.
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v' Alternative 2: Drive stopped at reference switch

1.

2.

The drive starts in the negative direction with acceleration A588 and velocity A587[1].
It changes its direction upon reaching the reference switch and continues its run with velocity A587[0].

When the drive comes to a stop after the reference switch, it changes direction again and continues at velocity
A587[1] until it reaches the zero pulse.

The current actual position is set to the value of reference position A569 upon reaching the zero pulse.
The drive comes to a standstill with deceleration A588.

If 143 is set to 1: Active, the drive is positioned at reference position A569.

Alternative 3: Drive is positioned between the reference and positive limit switches
The drive starts in the positive direction with acceleration A588 and velocity A587[0].

It changes its direction upon reaching the positive limit switch and continues its run until the reference switch is
reached.

Upon reaching the reference switch, the drive changes its velocity to A587[1] until it leaves the reference switch again.

The current actual position is set to the value of the reference position A569 after leaving the reference switch and
upon reaching the next zero pulse.

The drive comes to a standstill with deceleration A588.

If 143 is set to 1: Active, the drive is positioned at reference position A569.

82

10/2025 | ID 443077.03



10/2025 | ID 443077.03

STOBER 6 | More about CiA 402?
6.4.1.1.10 Referencing method J
Referencing method J determines the reference using a run to the centered reference switch.
LS- [ RS | LS+
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This method corresponds to the CiA 402 Homing method, 23: Homing on home switch initial positive operating mode.

Preparation
1. Activate referencing method J by setting parameter A586 to the value 23: Homing on home switch initial positive.
2. 1103:
Enter the data source for the reference switch.
3. A587[0], A587[1], A588, 144, A569:
Define the set values necessary for referencing.
Referencing
If the CiA 402 homing operating mode is active, a distinction is made between three referencing variants.
v Alternative 1: Drive is positioned between the negative limit and reference switches
1. The drive starts in the positive direction with acceleration A588 and velocity A587[0].
2. It changes its direction upon reaching the reference switch and continues its run with velocity A587[1] until it leaves
the reference switch again.
3. The current actual position is set to the value of the reference position A569 upon leaving the reference switch.
4. The drive comes to a standstill with deceleration A588.
5. If143is set to 1: Active, the drive is positioned at reference position A569.
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v' Alternative 2: Drive stopped at reference switch

1.

2.

The drive starts in the negative direction with acceleration A588 and velocity A587[1].

It changes its direction upon reaching the reference switch and continues its run with velocity A587[0] until it leaves
the reference switch.

When the drive comes to a stop after the reference switch, it changes direction and continues its run at velocity

A587[1] until it reaches the reference switch again.
The current actual position is set to the value of the reference position A569 upon reaching the reference switch.
The drive comes to a standstill with deceleration A588.

If 143 is set to 1: Active, the drive is positioned at reference position A569.

Alternative 3: Drive is positioned between the reference and positive limit switches
The drive starts in the positive direction with acceleration A588 and velocity A587[0].

Upon reaching the positive limit switch, the drive changes its direction and continues its run until it reaches the
reference switch.

Upon reaching the reference switch, the drive changes its velocity to A587[1] until it leaves the reference switch again.
The current actual position is set to the value of the reference position A569 upon leaving the reference switch.
The drive comes to a standstill with deceleration A588.

If 143 is set to 1: Active, the drive is positioned at reference position A569.
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6.4111 Referencing method K
Referencing method K determines the reference using a run to the centered reference switch and zero pulse.
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This method corresponds to the CiA 402 Homing method, 11: Homing on home switch and index pulse initial negative

operating mode.

Preparation

1.

Activate referencing method K by setting parameter A586 to the value 11: Homing on home switch and index pulse

initial negative.

1103:

Enter the data source for the reference switch.

A587[0], A587[1], A588, 144, A569:

Define the set values necessary for referencing.

153:

Define the start of the search for the zero pulse search.

Referencing

If the

v

1.

2.

CiA 402 homing operating mode is active, a distinction is made between three referencing variants.

Alternative 1: Drive is positioned between the reference and positive limit switches
The drive starts in the negative direction with acceleration A588 and velocity A587[0].

It changes its direction upon reaching the reference switch and continues its run with velocity A587[1] until it reaches

the next zero pulse after leaving the reference switch.
The current actual position is set to the value of reference position A569 upon reaching the zero pulse.
The drive comes to a standstill with deceleration A588.

If 143 is set to 1: Active, the drive is positioned at reference position A569.
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v' Alternative 2: Drive stopped at reference switch

1.

2.

The drive starts in the positive direction with acceleration A588 and velocity A587[1].
It changes its direction upon reaching the reference switch and continues its run with velocity A587[0].

When the drive comes to a stop after the reference switch, it changes direction again and continues at velocity
A587[1] until it reaches the zero pulse.

The current actual position is set to the value of reference position A569 upon reaching the zero pulse.
The drive comes to a standstill with deceleration A588.

If 143 is set to 1: Active, the drive is positioned at reference position A569.

Alternative 3: Drive is positioned between the negative limit and reference switches
The drive starts in the positive direction with acceleration A588 and velocity A587[0].

It changes its direction upon reaching the negative limit switch and continues its run until the reference switch is
reached.

Upon reaching the reference switch, the drive changes its velocity to A587[1] and continues its run until it reaches the

next zero pulse after leaving the reference switch.
The current actual position is set to the value of reference position A569 upon reaching the next zero pulse.
The drive comes to a standstill with deceleration A588.

If 143 is set to 1: Active, the drive is positioned at reference position A569.
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6.4.11.12 Referencing method L

Referencing method L determines the reference using a run to the centered reference switch.
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This method corresponds to the CiA 402 Homing method, 27: Homing on home switch initial negative operating mode.

Preparation
1. Activate referencing method L by setting parameter A586 to the value 27: Homing on home switch initial negative.
2. 1103:
Enter the data source for the reference switch.
3. A587[0], A587[1], A588, 144, A569:
Define the set values necessary for referencing.
Referencing

If the CiA 402 homing operating mode is active, a distinction is made between three referencing variants.

v’ Alternative 1: Drive is positioned between the reference and positive limit switches

1.

2.

The drive starts in the negative direction with acceleration A588 and velocity A587[0].

It changes its direction upon reaching the reference switch and continues its run with velocity A587[1] until it leaves

the reference switch again.
The current actual position is set to the value of the reference position A569 upon leaving the reference switch.
The drive comes to a standstill with deceleration A588.

If 143 is set to 1: Active, the drive is positioned at reference position A569.
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v' Alternative 2: Drive stopped at reference switch

1.

The drive starts with acceleration A588 and velocity A587[1] in the positive direction until it leaves the reference
switch.

It changes its direction upon leaving the reference switch and continues its run with velocity A587[0].

When the drive comes to a stop after the reference switch, it changes direction and continues its run at velocity
A587[1] until it reaches the reference switch again.

The current actual position is set to the value of the reference position A569 upon reaching the reference switch.
The drive comes to a standstill with deceleration A588.

If 143 is set to 1: Active, the drive is positioned at reference position A569.

Alternative 3: Drive is positioned between the negative limit and reference switches
The drive starts in the negative direction with acceleration A588 and velocity A587[0].

It changes its direction upon reaching the negative limit switch and continues its run until the reference switch is
reached.

When the reference switch is reached, the drive changes its velocity to A587[1] and continues its run until it leaves the

reference switch again.
The current actual position is set to the value of the reference position A569 upon leaving the reference switch.
The drive comes to a standstill with deceleration A588.

If 143 is set to 1: Active, the drive is positioned at reference position A569.
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6.4.1113 Referencing method M

This method determines the reference using a run to the zero pulse.

N
|

P '

This method corresponds to the CiA 402 Homing method, 33: Homing on index pulse negative operating mode.

Preparation

1. Activate referencing method M by setting parameter A586 to the value 33: Homing on index pulse negative.

2. A587[1], A588, 144, A569:

Define the set values necessary for the referencing.

Referencing

If the CiA 402 homing operating mode is active, referencing takes place as follows:
1. The drive starts in the negative direction with acceleration A588 and velocity A587[1].
2. The current actual position is set to the value of reference position A569 upon reaching the zero pulse.
3. The drive comes to a standstill with deceleration A588.

4. If 143 is set to 1: Active, the drive is positioned at reference position A569.
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6.4.1.1.14 Referencing method N

Referencing method N determines the reference using a run to the zero pulse.

/N

I
!
2p | | | |

This method corresponds to the CiA 402 Homing method, 34: Homing on index pulse positive operating mode.

Preparation
1. Activate referencing method N by setting parameter A586 to the value 34: Homing on index pulse positive.

2. A587[1], A588, 144, A569:

Define the set values necessary for the referencing.

Referencing

If the CiA 402 homing operating mode is active, referencing takes place as follows:
1. The drive starts in the positive direction with acceleration A588 and velocity A587[1].
2. The current actual position is set to the value of reference position A569 upon reaching the zero pulse.
3. The drive comes to a standstill with deceleration A588.

4. If 143 is set to 1: Active, the drive is positioned at reference position A569.
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6.4.1.1.15 Referencing method O

Referencing method O determines the reference by setting the reference to any position.

i - ]

This method corresponds to the CiA 402 Homing method, 37: Homing on current position operating mode and the

35: Homing on current position operating mode currently reserved in CiA 402.

Preparation

1. Activate referencing method O by setting parameter A586 to the value 37: Homing on current position.

2. A569:

Define the reference position.

Referencing
If the CiA 402 homing operating mode is active, referencing takes place as follows:

The current actual position is set to the value of the reference position A569.
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6.4.11.16 Referencing method P

Referencing method P determines the reference using a run with a torque/force stop.

I w 1
/ ,,

Y

Preparation

1. Activate referencing method P by setting parameter A586 to the value -1: Homing on torque/force limit initial
positive.

2. A587[0], A588, 144, A569:

Define the set values necessary for the referencing.

3. 128, 129:
Define the torque/force limit. If the actual torque for the time stored in 129 is above the limit defined in 128 for an

ongoing period, the torque/force limit is reached.

Information

In case of a selected value for the torque/force variable that is too big, the machine can be damaged. In case of a selected
value that is too small, an incorrect reference position may be applied.

Referencing
If the CiA 402 homing operating mode is active, referencing takes place as follows:
1. The drive starts in the positive direction with acceleration A588 and velocity A587[0].

2. The current actual position is set to the value of the reference position A569 when the torque/force limit is reached
and the time stored in 129 has elapsed.

3. The set values are set to the value 0 with deceleration A588.

4. If143is set to 1: Active, the drive is positioned at reference position A569.
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6.4.11.17 Referencing method Q
Referencing method Q determines the reference using a run with a torque/force stop and zero pulse.

Y

w
-

ZP

Preparation

1.

Activate referencing method Q by setting parameter A586 to the value -3: Homing on torque/force limit and index

pulse initial positive.

A587[0], A587[1], A588, 144, A569:

Define the set values necessary for referencing.

128, 129:
Define the torque/force limit. If the actual torque for the time stored in 129 is above the limit defined in 128 for an

ongoing period, the torque/force limit is reached.

153:

Define the start of the search for the zero pulse search.

Information

In case of a selected value for the torque/force variable that is too big, the machine can be damaged. In case of a selected

value

that is too small, an incorrect reference position may be applied.

Referencing

If the

1.

2.

CiA 402 homing operating mode is active, referencing takes place as follows:
The drive starts in the positive direction with acceleration A588 and velocity A587[0].

It changes its direction upon reaching the torque/force limit and when the time stored in 129 has passed, and

continues its run with velocity A587[1] until it reaches the next zero pulse.
The current actual position is set to the value of reference position A569 upon reaching the zero pulse.
The set values are set to the value 0 with deceleration A588.

If 143 is set to 1: Active, the drive is positioned at reference position A569.
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6.4.1.1.18 Referencing method R

Referencing method R determines the reference using a run with a torque/force stop.

I - I
| /'

Preparation

1

1. Activate referencing method R by setting parameter A586 to the value -2: Homing on torque/force limit initial
negative.

2. A587[1], A588, 144, A569:

Define the set values necessary for the referencing.

3. 128, 129:
Define the torque/force limit. If the actual torque for the time stored in 129 is above the limit defined in 128 for an
ongoing period, the torque/force limit is reached.

Information

In case of a selected value for the torque/force variable that is too big, the machine can be damaged. In case of a selected
value that is too small, an incorrect reference position may be applied.

Referencing
If the CiA 402 homing operating mode is active, referencing takes place as follows:
1. The drive starts in the negative direction with acceleration A588 and velocity A587[1].

2. The current actual position is set to the value of the reference position A569 when the torque/force limit is reached
and the time stored in 129 has elapsed.

3. The set values are set to the value 0 with deceleration A588.

4. If 143 is set to 1: Active, the drive is positioned at reference position A569.
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6.4.11.19 Referencing method S

Referencing method S determines the reference using a run with torque/force stop and zero pulse.

ZP

w
/

1

Preparation

1.

A586:
Activate referencing method S by setting this parameter to the value -4: Homing on torque/force limit and index pulse

initial negative.

A587[0], A587[1], A588, 144, A569:

Define the set values necessary for referencing.

128, 129:
Define the torque/force limit. If the actual torque for the time stored in 129 is above the limit defined in 128 for an

ongoing period, the torque/force limit is reached.

153:

Define the start of the search for the zero pulse search.

Information

In case of a selected value for the torque/force variable that is too big, the machine can be damaged. In case of a selected

value that is too small, an incorrect reference position may be applied.

Referencing

If the CiA 402 homing operating mode is active, referencing takes place as follows:

1.

2.

The drive starts in the negative direction with acceleration A588 and velocity A587[0].

It changes its direction upon reaching the torque/force limit and when the time stored in 129 has passed, and

continues its run with velocity A587[1] until it reaches the next zero pulse.
The current actual position is set to the value of reference position A569 upon reaching the zero pulse.
The set values are set to the value 0 with deceleration A588.

If 143 is set to 1: Active, the drive is positioned at reference position A569.
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6.4.2 Reference position

Depending on the referencing method A586, the actual position 180 is replaced by the reference position A569 during the
referencing event.

6.4.3 Reference retaining

STOBER offers a convenient drive-based referencing system. Depending on the encoder model used and the reference
management, different types of reference retaining (146) are offered.

If the reference is to be processed using controller-based operation and the drive controller is to provide absolute positions
based on the motor shaft, you have to take the following settings into account so that the reference can be reliably
processed by the controller. These settings provide you with the absolute position of the encoder based on the motor shaft
in the data format of the axis model, which you map in DriveControlSuite during commissioning.

6.4.3.1 Settings for control-based reference management
For reference retaining 146, select the 5: Direct absolute option.

This means that the absolute position of the encoder is directly mapped in the actual position (prerequisite: 102 = 0: Motor
encoder, actual position: A545).

Information

Afterwards, you must not perform any drive-based referencing using a referencing method or by setting the reference
directly, as this can cause the actual position to shift.

The axis model must be in relation to the output shaft of the motor und not the output after a mechanism such as a
gearbox.

Positions are generally provided in a 32-bit integer data format.

6.4.3.2 Preset — Scaling to 20 bits

Scaling to 20 bits corresponds to the preset for axis mode scaling in the CiA 402 application. If the position range
represented by 32 bits is exceeded, the controller must save the number of multi-turn overruns and take them into account
after a power-off/power-on for controller-based reference retaining.

6.4.3.3 Preset with greater dynamic range

In order to get greater dynamic range for the derived variables of velocity, acceleration, deceleration and jerk, you need the
following parameters:

= A310: Number of decimal places for the scaled transmission of the process data for velocities
= A311: Number of decimal places for the scaled transmission of the process data for acceleration, deceleration and jerk
= ]06: Number of decimal places for positions

If, for example, the velocity, acceleration and jerk values are to be weighted more heavily by a factor of 100, the following
steps are necessary:

= Change the value of A310 and A311to O

= Change the number of decimal places for the position 106 to 2
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6.4.4 Reference loss

Axis

In certain cases, an axis loses its reference, and its state changes from 186 = 1: Active to 186 = 0: Inactive.

Normal operation (axis)

During normal operation, encoder faults or actions can lead to a loss of the reference. If the reference was deleted by an

encoder event, it can subsequently be restored.

Information

Before restoring the reference, check the actual position displayed (180). If in doubt, do the referencing again. If relative

encoders are used or if the axis was still moving during the encoder fault, the actual position displayed may deviate from

the real actual position of the axis.

Event 76: Position encoder Encoder fault
Event 37: Motor encoder Encoder fault
Action 138 Deleted reference

Tab. 5: Loss of reference of the axis in normal operation

Actual position may still be correct, restoring
the reference is possible:

= Check the actual position (180).
= Confirm reference (1459) or re-reference
axis

When using the motor encoder as a position
encoder (102 = 0: Motor encoder), 2 faults are
triggered (37: Motor encoder and 76: Position
encoder), but it is possible that only one fault is
displayed in display parameter E82 and in the
fault memory.

Actual position may still be correct, restoring
the reference is possible:

= Check the actual position (180).

= Confirm reference (1459) or re-reference
axis

Action I138 deletes the reference but does not
change the actual position displayed.

Actual position may still be correct, restoring
the reference is not possible:

= Check the actual position (180).

= Reference the axis again
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Parameter changes (axis)

Changing individual parameters or transferring a new configuration with changed settings can lead to a loss of the
reference.

Changing parameters Changed axis model Actual position is undefined if one of the
following parameters was changed:

= A571 Polarity
= A584 Gear ratio
= A585 Feed constant
= B26 Motor encoder
= |00 Position range
= 101 Circular length
= |02 Position encoder
= |05 Type of axis
It is not possible to restore the reference:

= Reference the axis again

Changing parameters Changed encoder interface Actual position is undefined if a parameter of
the H group was changed.

It is not possible to restore the reference:
= Reference the axis again

Tab. 6: Reference loss of the axis due to parameter changes

Restarting the drive controller (axis)

Depending on the encoder type and method for reference retaining (146), the reference of a previously referenced axis is
restored or deleted after a restart.

By default (146 = 0: Normal), the reference for a multi-turn absolute encoder is retained after a restart if the axis was
referenced with this encoder. In all other cases, the reference is deleted as soon as the drive controller is switched off.

The method for reference retaining can be adapted in 146. In addition to the preset, the following further options are
available:

= Reference is retained if the measuring range covers the entire travel range

= Reference is retained as long as the position change in the switched-off state is less than the reference retention
window (148)

= Reference is retained regardless of the presence of an encoder
= Reference is retained regardless of the encoder type

= Reference is deleted when the drive controller is switched off
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Special case of incorrect motor connection (axis)

If a motor is inadvertently connected to the incorrect axis or the incorrect drive controller, such as after a case of service,
the drive controller behaves as follows after it is switched on:

= The axis changes to the non-referenced state (186 = 0: Inactive)
= The actual position displayed is undefined

However, the information from the original motor and the associated reference data are stored in the drive controller.
After switching off the drive controller, connecting the correct motor and restarting the drive controller, the reference is
restored and the actual position is displayed correctly (prerequisites: multi-turn absolute encoder, referenced axis and
preset for reference retaining 146 = 0: Normal).

Master encoder
Actual positions of the master encoder are used in the Drive Based Synchronous application for synchronous operation.

In all applications except the Drive Based Center Winder application, the actual position of the master encoder can be used
to pass on the position of another encoder attached to the machine to the control system. The drive controller transfers the
position from the encoder interface to the respective fieldbus.

Master encoders behave in a similar way to position encoders. In certain cases, a master encoder loses its reference, and its
state changes from G89 = 1: Active to G89 = 0: Inactive.

Normal operation (master encoder)

During normal operation, encoder faults can lead to a loss of the reference.

Event 77: Master encoder Encoder fault Actual position of the master encoder is
undefined, it is not possible to restore the
reference:

= Reference the master encoder again

Tab. 7: Reference loss of the master encoder in normal operation
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Parameter changes (master encoder)

Changing individual parameters or transferring a new configuration with changed settings can lead to a loss of the
reference.

Changing parameters Changed axis model Actual position of the master encoder is
undefined if one of the following parameters
was changed:

= G30 Position range master
= G40 Circular length master
= G47 Distance factor numerator master
= G48 Distance factor denominator master
= G104 Source master encoder
It is not possible to restore the reference:

= Reference the master encoder again

Changing parameters Changed encoder interface Actual position of the master encoder is
undefined if a parameter of the H group was
changed.

It is not possible to restore the reference:
= Reference the master encoder again

Tab. 8: Reference loss of the master encoder due to parameter changes

Restarting the drive controller (master encoder)

Depending on the encoder type and method for reference retaining (G35), the reference of a previously referenced master
encoder is restored or deleted after a restart.

By default (G35 = 0: Normal), the reference for a multi-turn absolute encoder is retained after a restart if this encoder was
used for referencing. In all other cases, the reference is deleted as soon as the drive controller is switched off.

The method for reference retaining can be adapted in G35. In addition to the preset, the following further options are
available:

= Reference is retained if the measuring range covers the entire travel range

= Reference is retained as long as the position change in the switched-off state is less than the reference retention
window (148)

= Reference is retained regardless of the presence of an encoder
= Reference is retained regardless of the encoder type

= Reference is deleted when the drive controller is switched off
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6.5 CiA 402 device control

The CiA 402 device control is based on the internationally standardized CiA 402 CANopen device profile for electric drives.
This profile describes the control sequence of a drive controller based on a device state machine. Each device state
represents a specific behavior.

The device state machine has to receive certain commands for state transitions. These commands are the result of a bit
combination in the control word in accordance with CiA 402. The bit combination in the status word indicates the current

state of the drive controller.

The following chapters describe the device states and the possible state transitions associated with them. You will also
learn whether certain actions are necessary on your part to reach the individual device states, what those actions are and
which user-specific factors you can parameterize yourself.

6.5.1 CiA 402 device state machine

The device state machine describes the different device states of the drive controller along with the possible state changes.

eeooo 13
— > Fault reaction active
io 14
Not ready to switch on Fault
1
o000 9 y 15
oo 10 Switch on disabled 12 e
2 7 0
\ 4
o000 3 . 17 o
P Ready to switch on <
3 6 @
Switched on
A
4 5 e
11.1 oo
) 11.2 . )
Operation enabled 16 Quick stop active

Fig. 12: CiA 402 device state machine: Device states and state changes

Priority levels are marked by dots. The more dots a state change has, the higher its priority. Accordingly, a state change

without any dots has the lowest priority.

Information

If you are using a gravity-loaded axis and a brake, always use a quick stop to switch the drive (state transition 11 in
accordance with the device state machine). This prevents the load from dropping until the brake is fully engaged.

101



6 | More about CiA 402? STOBER

6.5.2 Commands, states and transitions

The states provided by CiA 402 device control all have specific features. A state either transitions into another state
automatically or requires specific commands.

Parameter E48 shows the current device state of a drive controller.

6.5.2.1 Key

The following terms are used in the descriptions of the states and transitions:

Enable active Enable is active (A306 = 1: Active, source: terminal X1)
Enable is inactive Enable is inactive (A306 = O: Inactive, source: terminal X1)
Quick stop in case of Enable-off active Quick stop in case of Enable-off is active (A44 = 1: Active)

Quick stop in case of Enable-off inactive  Quick stop in case of Enable-off is inactive (A44 = 0: Inactive)

Quick stop end Standstill reached (1199 = 1: Active)
OR
Maximum quick stop duration has expired (A39)
Quick stop duration expired Maximum quick stop duration has expired (A39)
Quick stop option code = 2 A536 = 2: Slow down on quick stop ramp and transit into Switch On Disabled
Quick stop option code =6 A536 = 6: Slow down on quick stop ramp and stay in Quick Stop Active (quick

stop deceleration: A578)

Tab. 9: States, transitions and conditions: Terms

6.5.2.2 Commands

The device state machine has to receive certain commands for state changes. The commands are the result of a bit
combination in the control word A515 in accordance with CiA 402. The following table shows the states of the bits in A515
and their combination for the commands. Bits marked with X are irrelevant.

Command Bit 7 Bit 3 Bit 2 Bit 1 Bit 0
Fault reset Enable operation Quick stop Enable voltage Switch on
0 X 0

Shutdown

Switch on

Disable voltage

Disable operation

0 0
0 X
Quick stop 0 X
0 0
Enable operation 0 1

X

1
1
X
0
1
1
X

1

1 1

0 X

1 X

1 1

1 1
Fault reset Rising edge X X
Tab. 10: Bit combinations in the control word in accordance with CiA 402

Information

The STO safety function is mapped by the Disable voltage command, while drive-based braking within the SS1 safety
function is mapped by the Quick stop command.

Information

The brake control is not defined by the CiA 402 device profile. The brake is either controlled by the drive controller
(prerequisite: FOO = 1: Active and F92[0] = O: Internal (automatic)) or externally by a controller (prerequisite: FOO = 1: Active
and F92[0] = 1: External (plc), source: A515, bit 14).
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6.5.2.3 Not ready to switch on

Features
= Drive controller and safety module are initialized and tested
= The power unit as well as drive and activation functions are locked

= Brakes remain engaged

Transition to Switch on disabled (1)

The drive controller switches to the Switch on disabled state automatically after initialization and successful completion of
the self-test (typically approx. 30 s).

Transition to Fault reaction active (13), priority: ® © ® ® ®

Fault with or without fault reaction

6.5.2.4 Switch on disabled

Features
= |nitialization has been completed
= Self-test was successfully completed
= The power unit as well as drive and activation functions are locked
= Brakes are or remain engaged in the event of an inactive release override
Possible causes of a switch-on lockout include:
1.  Insufficient or no supply voltage/DC link feed-in
2. STO safety function is active
3. Disable voltage command
4.  Quick stop command (cause only in the Switch on disabled, Ready to switch on and Switched on states)

5. Control panel or local operation is active (cause only in the Switch on disabled, Ready to switch on and Switched on

states)

For the exact cause of a switch-on lockout, refer to parameter E49.

Transition to Ready to switch on (2)
Shutdown command

AND

Enable active

AND

No cause for a switch-on lockout

Transition to Fault reaction active (13), priority: ® ®© ® ® ®

Fault with or without fault reaction
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6.5.2.5 Ready to switch on

Features
= Power unit and drive function are disabled

= Drive controller is ready to switch on

= Brakes are or remain engaged in the event of an inactive release override

Transition to Switched on (3)

Switch on command

Transition to Switch on disabled (7), priority: ®
Quick stop command

OR

Disable voltage command

OR

Enable inactive

OR

Cause for a switch-on lockout

Transition to Fault reaction active (13), priority: ® ® ® ® ®

Fault with or without fault reaction

6.5.2.6 Switched on

Features
= Power unit is ready for operation

= Drive function is locked; set values are not processed

= Brakes are or remain engaged in the event of an inactive release override

Transition to Operation enabled (4)

Enable operation command

Transition to Ready to switch on (6), priority: ®

Shutdown command

Transition to Switch on disabled (10), priority: ® ®
Disable voltage command

OR

Enable inactive

OR

Cause for a switch-on lockout

Transition to Fault reaction active (13), priority: ® ®© ® ® ®

Fault with or without fault reaction
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6.5.2.7 Operation enabled

Information

If you are using a gravity-loaded axis and a brake, always use a quick stop to switch the drive (state transition 11 in
accordance with the device state machine). This prevents the load from dropping until the brake is fully engaged.

Information

SS1 and SS2 are executed in the Operation enabled state. SS2 always remains in this state. The brake does not engage in
case of SS2, so continuing is possible without any wait time. SS1 leads to transition 9.

Features
= Power unit is switched on
= Drive function is enabled, set values are processed
= Brakes are released:
e csp, csv, cst, vl, pv or pt operating mode: upon first active motion command

* pp, ip or homing operating mode: depending on the operating mode-specific bit 4

Transition to Switched on (5), priority: ®

This transition brings the drive to an uncontrolled standstill. The power unit is disabled and axis movement is no longer
controlled by the drive controller.

Disable operation command

Transition to Ready to switch on (8), priority: ® ® ®

This transition brings the drive to an uncontrolled standstill. The power unit is disabled and axis movement is no longer
controlled by the drive controller.

Shutdown command AND quick stop in case of Enable-off inactive

Transition to Switch on disabled (9), priority: ® ® ® ®

This transition brings the drive to an uncontrolled standstill. The power unit is disabled and axis movement is no longer
controlled by the drive controller.

Disable voltage command

OR

Enable inactive AND quick stop in case of Enable-off inactive

OR

Cause for a switch-on lockout

In addition to CiA 402: Transition to Quick stop active (11.1), priority: ® ®

Shutdown command AND quick stop in case of Enable-off active

Transition to Quick stop active (11.2)

Quick stop command

OR

Enable inactive AND quick stop in case of Enable-off active

Transition to Fault reaction active (13), priority: ® ® ® ® ®

Fault with or without fault reaction
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6.5.2.8 Quick stop active

Features
= Power unit is switched on; drive function is enabled
= A quick stop is executed

= Brakes remain or are released

Transition to Switch on disabled (12), priority: ® ®

Quick stop option code = 2 AND one of the following conditions:

Disable voltage command

OR

Enable inactive AND quick stop in case of Enable-off inactive

OR

Enable inactive AND quick stop in case of Enable-off active AND quick stop end
OR

Cause for a switch-on lockout

Transition to Fault reaction active (13), priority: ® ®© ® ® ®

Fault with or without fault reaction

Transition to Operation enabled (16)
Enable operation command

AND

Enable active

AND

Quick stop option code = 6

In addition to CiA 402: Transition to Ready to switch on (17), priority: ®
Shutdown command AND Enable active AND quick stop end
OR

Shutdown command AND Enable active AND quick stop duration expired

6.5.2.9 Fault reaction active
= Adrive error has occurred
= Fault reaction is executed depending on the respective fault event

= Brakes are activated depending on the respective fault reaction

Transition to Fault (14)

After a completed fault reaction, the drive controller automatically switches to the Fault state.
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6.5.2.10 Fault
= Adrive error has occurred
= The fault reaction is finished
= The power unit as well as drive and activation functions are locked

= Brakes are engaged in the event of an inactive release override

Transition to Switch on disabled (15)
Fault reset command (rising edge)

After the fault cause is eliminated and the fault message is the acknowledged, the drive controller automatically switches to
the Switch on disabled state.
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6.6 Operating modes in detail

The following sections provide on the operating modes of the CiA 402 application.

Switching between a controller-based operating mode (ip, csp, csv or cst) and a drive-based operating mode (pp, vl, pv, pt)
is only possible at a standstill (1199 = 1: Active), i.e. the absolute value of the actual velocity A553 is less than the velocity
window C40.

6.6.1 Interpolated position mode (ip)

Interpolated position mode lets you implement a cyclical position specification through the controller. Position control
takes place in the drive. The position control receives a set position (with time stamp) and, if applicable, a set velocity
processed as a feedforward control. The application interpolates the set values and passes them to the position control.
Acceleration and braking ramps or jerk limits are not taken into account.

Information

Note that it is not possible to specify a set of set values for interpolated position mode, just an individual set value.

6.6.1.1 Input and output signals

Buffer and
interpolation Limit

A601 Interpolation data record

»| FIFO
(60C1 hex)

A545 Position actual value
(6064 hex)

A603 Interpolation data configuratiol
(60C4 hex) > | lin

A600 Interpolation sub mode select
(60C0 hex) o

A568 Position range limit
(6078 hex)

A570 Software position limit
(607D hex) Motion

core

A592 Velocity offset
(60B1 hex)

Y

A578 Quick stop deceleration
(6085 hex) |

A553 Velocity actual value
$S1/SS2 deceleration (606C hex)

|

A593 Torque offset
(60B2 hex)

Y

A559 Maximum torque

Y

(6072 hex)
A602 Interpolation time period o A564 Torque actual value o
(60C2 hex) o (6077 hex) o

Fig. 13: Interpolated position mode: Input and output signals
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6.6.1.2 Control commands and status information

For the interpolated position operating mode, parameter A541 must be set to 7. The active operating mode is output in the
parameter A542. If the interpolated position operating mode is active, the information 7: Interpolated position mode is
there.

In control word A515, the following operating mode-specific bit is assigned:

4 Enable interpolation Enable interpolation:
0 = inactive; 1 = active

Tab. 11: Interpolated position mode: Operating mode-specific bits in the control word

The following operating mode-specific bit is assigned in status word A516:

12 IP mode active Interpolation and transmission of cyclic set position active (source: A927):
0 =inactive; 1 = active

Tab. 12: Interpolated position mode: Operating mode-specific bits in the status word

6.6.1.3 Process data mapping
Interpolated position mode cannot be used with the standard mapping of the CiA 402 application.

The following table shows the operating mode-specific mapping for the receive process data. For fieldbus communication
via EtherCAT, the process data mapping is done via parameter A225 — A228. If necessary, the mapping can be customized.

WORD Control word A515
Communication object 6040 hex in accordance with CiA 402

2 INT8 Modes of operation A541
Communication object 6060 hex in accordance with CiA 402

3-6 INT32 Interpolation data record A601

Communication object 60C1 hex in accordance with CiA 402

Tab. 13: SD6: Receive process data (Interpolated position mode)

The following table shows the operating mode-specific mapping for the transmit process data. For fieldbus communication
via EtherCAT, the process data mapping is done via parameter A233 — A236. If necessary, the mapping can be customized.

WORD Statusword A516
Communication object 6041 hex in accordance with CiA 402

2 INT8 Modes of operation display  A542
Communication object 6061 hex in accordance with CiA 402

3-6 INT32 Position actual value A545
Communication object 6064 hex in accordance with CiA 402

Tab. 14: SD6: Transmit process data (Interpolated position mode)

109



6 | More about CiA 402? STOBER

6.6.2 Cyclic synchronous position mode (csp)

Cyclic synchronous position mode lets you implement a cyclical position specification through a controller. Position control
takes place in the drive. The position control receives a set position (with time stamp) and, if applicable, a set velocity
processed as a feedforward control. The application interpolates the set values and passes them to the position control.
Acceleration, braking or jerk limits are not taken into account.

6.6.2.1 Input and output signals

Limit

A567 Target position A545 Position actual value
(607A hex) (6064 hex)

Y
A
\j

A568 Position range limit
(6078 hex)

A570 Software position limit
(607D hex)

A592 Velocity offset
(60B1 hex)

\i

SSI/SSZ Motion
A578 Quick stop deceleration o | core

(6085 hex) I A553 Velocity actual value
—_— e P

$S1/SS2 deceleration o (606C hex)

\j

A593 Torque offset
(60B2 hex)

Y

A559 Maximum torque
(6072 hex)

\i

A602 Interpolation time period A564 Torque actual value
(60C2 hex) (6077 hex)

\i
\J

Fig. 14: Cyclic synchronous position mode: Input and output signals

6.6.2.2 Control commands and status information

For Cyclic synchronous position mode, parameter A541 must be set to 8. The active operating mode is output in the
parameter A542. If the cyclic synchronous position operating mode is active, the information 8: Cyclic synchronous position
mode is there.

No operating mode-specific control commands have to be specified in control word A515.

The following operating mode-specific bits are assigned in status word A516:

12  Target position Drive follows set position (source: A927):
0 = inactive; 1 = active

13  Following error Following error (source: A928):
0 =inactive; 1 = active

Tab. 15: Cyclic synchronous position mode: Operating mode-specific bits in the status word
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6.6.3 Cyclic synchronous velocity mode (csv)

Cyclic synchronous velocity mode lets you implement a cyclical velocity specification through a controller. Velocity control
takes place in the drive. The velocity control receives a set velocity (with time stamp). The application interpolates the set
values and passes them to the velocity control. Acceleration, braking or jerk limits are not taken into account.

6.6.3.1 Input and output signals
A638 Target velocity (1) o A545 Position actual value
(60FF hex) o o (6064 hex) o
A592 Velocity offset
(60B1 hex)
. . SS1/SS2
A578 Quick stop deceleration o |
(6085 hex) | : ;
Motion [A553 Velocity actual value -
SS1/SS2 deceleration o core (606C hex)
A559 Maximum torque o
(6072 hex) o
A593 Torque offset o
(60B2 hex) o
A602 Interpolation time period o A564 Torque actual value o
(60C2 hex) o (6077 hex) o

Fig. 15: Cyclic synchronous velocity mode: Input and output signals

6.6.3.2 Control commands and status information

For Cyclic synchronous velocity mode, parameter A541 must be set to 9. The active operating mode is output in the
parameter A542. If the cyclic synchronous velocity operating mode is active, the information 9: Cyclic synchronous velocity
mode is there.

No operating mode-specific control commands have to be specified in control word A515.

The following operating mode-specific bits are assigned in status word A516:

12 Target velocity Drive follows set velocity (source: A927):
0 =inactive; 1 = active

Tab. 16: Cyclic synchronous velocity mode: Operating mode-specific bits in the status word
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6.6.4 Cyclic synchronous torque mode (cst)

Cyclic synchronous torque mode lets you implement a cyclical torque/force specification through a controller. Torque/force
control takes place in the drive. The control receives a set torque or set force (with time stamp). The application
interpolates the set values and passes them to the torque/force control. Acceleration, braking or jerk limits are not taken
into account. A velocity limit is available.

6.6.4.1 Input and output signals
A558 Target torque (1) o A545 Position actual value o
(6071 hex) o o (6064 hex) o
A593 Torque offset
(60B2 hex)
. . $51/5S2

A578 Quick stop deceleration o |
(6085 hex) I A553 Velocity actual value

————— —

SS1/SS2 deceleration . (606C hex)
Motion

A559 Maximum torque o core
(6072 hex) o

A602 Interpolation time period

Y

(60C2 hex)
G472 >
G475 > A564 Torque actual value

y

(6077 hex)

Fig. 16: Cyclic synchronous torque mode: Input and output signals

Information

By default, the velocity limit is active (G472 and G475 = 0%). Increase the values according to the requirements of your
application to enable motion.

6.6.4.2 Control commands and status information

For Cyclic synchronous torque mode, parameter A541 must be set to 10. The active operating mode is output in the
parameter A542. If the cyclic synchronous torque operating mode is active, the information 10: Cyclic synchronous torque
mode is there.

No operating mode-specific control commands have to be specified in control word A515.

The following operating mode-specific bits are assigned in status word A516:

12 Target torque Drive follows set force/torque (source: A927):
0 =inactive; 1 = active

Tab. 17: Cyclic synchronous torque mode: Operating mode-specific bits in the status word
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6.6.5 Profile position mode (pp)

Profile position mode lets you implement a target position specification through a controller. The calculation of the motion

profile and position control takes place in the drive. The drive receives a target position, set velocity, set acceleration, set

deceleration and set jerk. The application uses this to calculate the motion profile and passes it to the position control.

6.6.5.1 Input and output signals

A567 Target position

(607A hex)

A568 Position range limit
(607B hex)

—_-o
o
Y
3
v

A570 Software position limit
(607D hex)

A574 Profile velocity

(6081 hex)

Y
el
y

A572 Max profile velocity
(607F hex)

A576 Profile acceleration
(6083 hex)

A577 Profile deceleration

vy v
3
Y

(6084 hex)
A
A604 Max acceleration -
(60C5 hex) o
Minimum
A605 Max deceleration o
(60C6 hex) o
$S1/SS2
A578 Quick stop deceleration o |
(6085 hex) |
———— P
SS1/SS2 deceleration o
A559 Maximum torque -
(6072 hex) o
Limit Quick stop or
$S1/5S2
A590 Profile jerk .
—0 |
(60A4 hex) |
_l_._»
A 0 —o
116

Motion
core

A545 Position actual value

(6064 hex)

A553 Velocity actual value

\j

(606C hex)

A564 Torque actual value

\J

Fig. 17: Profile position mode: Input and output signals

Information

A velocity override via A340 is taken into account.

(6077 hex)

\j

113



6 | More about CiA 402? STOBER

6.6.5.2 Control commands and status information

For Profile position mode, parameter A541 must be set to 1. The active operating mode is output in the parameter A542. If
the profile position operating mode is active, the information 1: Profile position mode is there.

In control word A515, the following bits are used specific to the operating mode:

4 New setpoint Accept new set position and start motion:
0, 1 =inactive;
0 - 1 =depending on bit 5, accept set position and start motion

5  Change set immediately Accept new set position with active motion
0 = accept set position with bit 4 only at standstill and start motion (prerequisite:
1199 = 1: Active);
1 = accept set position with bit 4 immediately and start motion; active motion is
interrupted

6  Abs/rel Absolute set position/relative distance:
0 = set position is an absolute position;
1 = set position is a distance relative to the last set position A567 (prerequisite: A621
= X...X00 bin) or
1 = set position is a distance relative to the current actual position A545
(prerequisite: A621 = X...X10 bin)

8 Stop Execute stop:
0 = inactive;
1 = stop axis with deceleration of the motion profile until standstill (deceleration:
A577; standstill: 1199 = 1: Active)
0 - 1 = motion is not continued

Tab. 18: Profile position mode: Operating mode-specific bits in the control word

The following operating mode-specific bits are assigned in status word A516:

10 Target reached Target position reached (source: A925):
0 =inactive; 1 = active

12  Setpoint acknowledge Target position accepted by motion core (source: A927):
0 = inactive; 1 = active

13  Following error Following error (source: A928):
0 =inactive; 1 = active

Tab. 19: Profile position mode: Operating mode-specific bits in the status word
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6.6.6 Velocity mode (vl)

Velocity mode lets you implement a set velocity specification through a controller. The velocity ramp calculation and
velocity control take place in the drive. The drive receives a set velocity, set acceleration and set deceleration. The
application uses this to calculate the motion profile and passes it to the velocity control.

6.6.6.1 Input and output signals

Limit

A517 vl target velocity A518 vl velocity demand

(6042 hex) (6043 hex)

Y
X
Y

A527 vl dimension factor
(604C hex)

A526 vl set-point factor
(604B hex)

A521 vl velocity min max amount A519 vl velocity actual value

\j

(6046 hex) (6044 hex)

A527 vl dimension factor
(604C hex)

A523 vl velocity acceleration
(6048 hex)

Motion
core

A527 vl dimension factor
(604C hex)

A524 vl velocity deceleration
(6049 hex)

1]

A527 vl dimension factor

(604C hex) 551/552
A525 vl velocity quick stop =/><\ o |
(604A hex) |
———
A527 vl dimension factor SS1/SS2 deceleration o
(604C hex)
Quick stop or
SS1/SS2
116 ,
o |
I
_l_._»
QO —o

Fig. 18: Velocity mode: Input and output signals

Information

A velocity override via A340 is taken into account.

\J
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6.6.6.2

Control commands and status information

For Velocity mode, parameter A541 must be set to 2. The active operating mode is output in the parameter A542. If

Velocity mode is active, the information 2: Velocity mode is there.

In control word A515, the following bits are used specific to the operating mode:

4 Enable ramp

Activate velocity control:

0 = velocity specification = 0;
1 = velocity specification by A517

5  Unlock ramp

Unlock locked velocity control:

0 = velocity specification = last velocity specification before freeze;
1 = velocity specification by A517

6  Reference ramp

Deactivate set velocity:

0 = velocity specification = 0;
1 = velocity specification by A517

8 Stop Execute stop:

0 = inactive;

1 = stop axis with deceleration of the motion profile until standstill (deceleration:
A577; standstill: 1199 = 1: Active)
0 = 1 =motion is continued immediately

Tab. 20: Velocity mode: Operating mode-specific bits in the control word

No operating mode-specific bits are assigned in status word A516.

6.6.6.3 Process data mapping

Velocity mode cannot be used with the standard mapping of the CiA 402 application.

The following table shows the operating mode-specific mapping for the receive process data. For fieldbus communication

via EtherCAT, the process data mapping is done via parameter A225 — A228. If necessary, the mapping can be customized.

WORD Control word
2 INT8 Modes of operation
3-4 INT vl target velocity

Tab. 21: SD6: Receive process data (Velocity mode)

A515
Communication object 6040 hex in accordance with CiA 402

A541
Communication object 6060 hex in accordance with CiA 402

A517
Communication object 6042 hex in accordance with CiA 402

The following table shows the operating mode-specific mapping for the transmit process data. For fieldbus communication

via EtherCAT, the process data mapping is done via parameter A233 — A236. If necessary, the mapping can be customized.

WORD Statusword
2 INT8 Modes of operation display
3-4 INT vl velocity actual value

Tab. 22: SD6: Transmit process data (Velocity mode)

A516
Communication object 6041 hex in accordance with CiA 402

A542
Communication object 6061 hex in accordance with CiA 402

A519
Communication object 6044 hex in accordance with CiA 402
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6.6.7 Profile velocity mode

(pv)

Profile velocity mode lets you implement a set velocity specification through a controller. The calculation of the motion

profile and position control takes place in the drive. The drive receives a set velocity, set acceleration, set deceleration and

set jerk. The application uses this to calculate the motion profile and passes it to the velocity control.

6.6.7.1 Input and output signals

A638 Target velocity

Limit

Y

(60FF hex)

A572 Max profile velocity

\i

(607F hex)

A576 Profile acceleration

Limit

Y

(6083 hex)

A577 Profile deceleration

\i

\i

(6084 hex)

A604 Max acceleration
(60C5 hex)

Y

Minimum
A605 Max deceleration
(60C6 hex)

Y

A578 Quick stop deceleration

$51/5S2

o |

(6085 hex)

$51/SS2 deceleration

|
_l_._»

A559 Maximum torque

]

(6072 hex)
Limit

-
|

Quick stop or

SS1/SS2
A590 Profile jerk '
! —o0 |
(60A4 hex) |
_l_._»
A 00 —o
116

Motion
core

A545 Position actual value

(6064 hex) >
A553 Velocity actual value o
(606C hex) o
A564 Torque actual value o

Fig. 19: Profile velocity mode: Input and output signals

Information

A velocity override via A340 is taken into account.

(6077 hex)
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6.6.7.2 Control commands and status information

For Profile velocity mode, parameter A541 must be set to 3. The active operating mode is output in the parameter A542. If
the Profile velocity mode is active, the information 3: Profile velocity mode is there.

In control word A515, the following bits are used specific to the operating mode:

8 Stop Execute stop:
0 = inactive;
1 = stop axis with deceleration of the motion profile until standstill (deceleration:
A577; standstill: 1199 = 1: Active)
0 - 1 =motion is continued immediately

Tab. 23: Profile velocity mode: Operating mode-specific bits in the control word

The following operating mode-specific bits are assigned in status word A516:

10 Target reached Set velocity reached (source: A925):
0 =inactive; 1 = active

12  Speed Velocity is zero (source: A927):
0 = inactive; 1 = active

13 Max slippage error Velocity error (difference in the amount of the effective set and actual velocities
greater than velocity window C40; signal source: A928):
0 =inactive; 1 = active

Tab. 24: Profile velocity mode: Operating mode-specific bits in the status word
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6.6.8 Profile torque mode (pt)

Profile torque mode lets you implement a reference set torque/force specification through a controller. The calculation of
the motion profile and torque/force control takes place in the drive. The drive receives a set torque or set force. The
application uses this to calculate the motion profile and passes it to the torque/force control.

6.6.8.1 Input and output signals
A558 Target torque o A545 Position actual value
(6071 hex) o (6064 hex) o
A561 Torque slope o
(6078 hex) o
SS1/SS2

A578 Quick stop deceleration o |
(6085 hex) I A553 Velocity actual value

_l_._» -

$51/SS2 deceleration o Motion | (606Chex)
core
A559 Maximum torque o
(6072 hex) o
G472 _
G475 o A564 Torque actual value o
o (6077 hex) o

Fig. 20: Profile torque mode: Input and output signals

Information

By default, the velocity limit is active (G472 and G475 = 0%). Increase the values according to the requirements of your
application to enable motion.

6.6.8.2 Control commands and status information

For Profile torque mode, parameter A541 must be set to 4. The active operating mode is output in the parameter A542. If
the Profile torque mode is active, the information 4: Profile torque mode is there.

In control word A515, the following bits are used specific to the operating mode:

8 Stop Execute stop:
0 = inactive;
1 = stop axis with deceleration of the motion profile until standstill (deceleration:
A577; standstill: 1199 = 1: Active)
0 - 1 = motion is continued immediately

Tab. 25: Profile torque mode: Operating mode-specific bits in the control word

The following operating mode-specific bits are assigned in status word A516:

10 Target reached Set force/set torque reached (difference in the amount of effective set force/set
torque and actual force/actual torque greater than torque/force window, source:
A925):
0 =inactive; 1 = active

Tab. 26: Profile torque mode: Operating mode-specific bits in the status word
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6.6.9 Homing mode

During referencing in the homing operating mode, the machine and controller reference system are coordinated together

using absolute values. The drive can perform absolute movements, i.e. movements to defined positions, only in the

referenced state.

For more detailed information on the individual referencing methods, see Referencing methods [P 70].

6.6.9.1 Input and output signals

A586 Homing method

\i

(6098 hex)

A569 Home offset

(607C hex) Homing o
. method
A587 Homing speeds o
(6099 hex) o
A588 Homing acceleration Limit
(609A hex) o
o -
A
110
Limit
> .
A604 Max acceleration o I
(60C5 hex) o
. Minimum
A605 Max deceleration o
(60C6 hex) o
$51/5S52
A578 Quick stop deceleration o |l
(6085 hex) |
$51/SS2 deceleration
A559 Maximum torque o
(6072 hex) o
Limit Quick stop or 51/
SS2
. —— |
I
—e———— P
I o

116

Fig. 21: Homing mode: Input and output signals

Motion
core

A545 Position actual value

(6064 hex)

A553 Velocity actual value

y

(606C hex)

A564 Torque actual value

y

(6077 hex)

\j
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6.6.9.2 Control commands and status information

For the homing operating mode, parameter A541 must be set to 6. The active operating mode is output in the parameter
A542. If the Homing mode is active, the information 6: Homing Mode is there.

In control word A515, the following bit is assigned specific to the operating mode:

4  Homing operation start Start referencing:
0, 1 =inactive; 0 > 1 = active

Tab. 27: Homing mode: Operating mode-specific bits in the control word

The following operating mode-specific bits are assigned in status word A516:

10 Target reached Referencing completed (source: A925):
0 =inactive; 1 = active

12 Homing attained Reference set (source: A926):
0 =inactive; 1 = active

13 Homing error Error during referencing (source: A927):
0 = inactive; 1 = active

Tab. 28: Homing mode: Operating mode-specific bits in the status word
0 0 0 Referencing active

Referencing canceled or not started

Reference set, but referencing not finished

Error during referencing, velocity is not zero

L O kB R, O

0 1
0 0
0 1 Referencing completed successfully
1 0
1 0

Error during referencing, velocity is zero

Tab. 29: Homing mode: Meaning of operating mode-specific bit combinations in the status word

121



6 | More about CiA 402?

STOBER

6.6.10 Jog

The STOBER-specific jog operating mode lets you move the drive during commissioning, in emergency operation or during

setup and repair work, including independently of the controller.

You can either use the jog operating mode through the display of the SD6 drive controller, the jog control panel or a

controller that applies the manual movement.

6.6.10.1 Input and output signals

\i

Limit
114 2
100
i
|

Y

A568 Position range limit o A
(6078 hex)
—_—1 0]
A570 Software position limit o
(607D hex) © Limit
112 _ % _
A
110
Limit
113 _
145 . 7‘ o
A
A604 Max acceleration o
(60C5 hex) o
Minimum
A605 Max deceleration -
(60C6 hex) o
SS1/5S2
A578 Quick stop deceleration |
(6085 hex) °
_l_._»
SS1/SS2 deceleration o
A559 Maximum torque o
(6072 hex) o
Limit Quick stop or
$S1/SS2
118 ,
> ———o |
|
—_— e P
A 00 —o
116

Fig. 22: Jog: Input and output signals

Motion
core

A545 Position actual value

(6064 hex)

A553 Velocity actual value

\j

(606C hex)

A564 Torque actual value

\j

(6077 hex)

\J
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6.6.10.2 Function

If the Jog positive bit is set to 1, the drive accelerates to velocity 112 with the ramp 113 and the jerk limit 118. If the Jog
positive bit is set to 0, however, the drive brakes to a standstill with the ramp 145. In the event of an active Jog negative
signal, the drive accelerate to -112. Acceleration and jerk apply in the same way.

+H12-4 1 | 2
| 3
|
|
n T T
| | |
| 1 |
| | |
: ! :
124 : ! |
|
L I | ! |
I |
Jog pos.
BPO o _—I I I I
| |
1 —
Jog neg. I l

\j

Fig. 23: Jog — Accelerating and braking

1 113 Jog acceleration
2 145 Jog deceleration
3 118 Jog jerk

If the Jog positive and Jog negative bits are set to 1 simultaneously, the drive brakes to a standstill.

+112 — |
|
:
I
. | i |
| I I
| I I
| : I
1124 | | I |
: . : .
19 i I :
Jog pos.
gpos. o | | l !
I |
1_
Jog neg. I l

\j

Fig. 24: Jog — Response to contradictory signals
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6.6.10.3 Control commands and status information

For the jog operating mode, parameter A541 must be set to —1. The active operating mode is output in the parameter
A542. If the jog operating mode is active, the information -1: Jog is there.

In control word A515, the following bits are used specific to the operating mode:

4 Jog positive Jog in the positive direction:
0 =inactive; 1 = active
5 Jog negative Jog in the negative direction:
0 = inactive; 1 = active
8 Stop Execute stop:
0 = inactive;
1 = stop axis with deceleration of the motion profile until standstill (deceleration:

A577; standstill: 1199 = 1: Active)
0 - 1 = motion is continued immediately

Tab. 30: Jog: Operating mode-specific bits in the control word

No operating mode-specific bits are assigned in status word A516.
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6.7

The individual operating modes feature special motion commands that are based on the PLCopen standard and are supplemented by 4 manufacturer-specific motion commands

Operating modes in accordance with CiA 402 - Commands

(MC_DoNothing, MC_MoveSpeed, MC_CyclicSpeed and MC_CyclicPosition). Any motion command — except MC_Stop — can be overwritten during execution.

In order to execute a command, the drive controller must not be in the Fault or Quick stop active device state.

Operating mode in accordance | Additional settings Command Feature Control type Necessary motion variables
with CiA 402 (A541)

-1:Jog

0: No mode

1: Profile position mode

A515, bit6=0

A515, bit6=1

A621, bit 0 =0 and
bitl=1

A515, bit6=1

A621, bit 0=0and
bit1=0

0: MC_DoNothing
1: MC_MoveAbsolute

2: MC_MoveRelative

3: MC_MoveAdditive

Controller-dependent
movement of the drive

Move to an absolute position

Move a distance relative to the
actual position

Move a distance relative to the
set position

Position or velocity

Position

Position

Position

Alternative parameters and motion

variables

Position

Velocity, override
Acceleration
Deceleration

Jerk

Position

Velocity, override
Acceleration
Deceleration

Jerk

Position

Velocity, override
Acceleration
Deceleration

Jerk
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Operating mode in accordance | Additional settings Command Feature Control type Necessary motion variables
with CiA 402 (A541)

2: Velocity mode

3: Profile velocity mode

6: Homing mode

4: Profile torque mode®

a)

7: Interpolated position mode

8: Cyclic synchronous position
mode?

9: Cyclic synchronous velocity
mode®

A515, bits 4, 5 and 6

8: MC_MoveSpeed

8: MC_MoveSpeed

6: MC_Home

9: MC_TorqueControl

10: MC_CyclicPosition

10: MC_CyclicPosition

7: MC_CyclicSpeed

Move without end with set
velocity

Move without end with set
velocity

Reference the axis

Move infinitely at set torque/
force

Move to the next position value
without calculating ramps

Move to the next position value
without calculating ramps

Move without end with set
velocity without calculating
ramps

Velocity = Velocity, override
= Acceleration
= Deceleration
= Maximum velocity

= Minimum velocity

Velocity = Velocity, override
= Acceleration
= Deceleration

= Jerk

Depending on selected *® Velocity, override
homing method
& = Acceleration
= Deceleration

= Jerk

= Torque/force

Torque/force = Torque/force

= Torque/force ramps

Position Position
Position Position
Velocity Velocity

126

10/2025 | ID 443077.03



10/2025 | ID 443077.03

STOBER 6 | More about CiA 402?

Operating mode in accordance | Additional settings Command Feature Control type Necessary motion variables
with CiA 402 (A541)

10: Cyclic synchronous torque 9: MC_TorqueControl Move without end with set Torque/force Torque/force
mode? torque/force without
calculating ramps

Tab. 31: Comparison of the operating modes in accordance with CiA 402 and the commands based on PLCopen

a) Can only be used in combination with cyclic set values

For detailed information on the motion commands, refer to the associated manual (see Detailed information [P 145]).
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6.8 Feedforward control

The feedforward control lessens the work for the position controller and reduces slip error.

A feedforward control lets you run the following operating modes:
= Interpolated position mode
= Cyclic synchronous position mode
You can select various settings:
= With controller-generated (external) feedforward control
= With drive-generated (internal) feedforward control
= Without feedforward control

Preferable to use movement with feedforward control.

Information

In the case of multi-axis motion, a feedforward control of nearly 100% is necessary for the most accurate trajectory.

If your controller calculates set velocities, you should use it for feedforward control. If your controller only calculates set
positions, you can fall back on the drive-led feedforward control. You may have to determine the optimal feedforward

control value for your system using an iterative process.

Always refer to the manual for the drive controller for optimization of the regulating behavior (see Detailed information

[» 145)).

6.8.1 Controller-generated external feedforward control

You use controller-generated feedforward control if the feedforward control is to be changed during operation in order to

achieve movement optimization.

a /

Interpolation
Xlset,cycl > B X 1set
1
Interpolation
Vlset,cycl ——> 2 4’?—> Vlset

125

Fig. 25: Controller-generated external feedforward control
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6.8.2

Drive-generated internal feedforward control

Use drive-generated internal feedforward control if the feedforward control set once delivers the desired results for all

operation.

Xlset,cycl

Fig. 26: Drive-generated internal feedforward control

6.8.3

I

.

Interpolation

/

Without feedforward control

-
B> Xiset

d/dt *%—» Vit

Select this setting if the overall setting of the drive controller is optimized to the extent that active feedforward control

leads to worse overall regulation.

Xlset,cycl

Vlset =0

-

.

Interpolation

/

-
B Xiset

Fig. 27: Without feedforward control

\j
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6.8.4 Setting up feedforward controlin DS6

The following chapters cover the setup of feedforward control with the aid of the DriveControlSuite commissioning

software.
6.8.4.1 Setting up controller-generated external feedforward control
1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.
2. Select the Control cascade wizard > Position controller.
3. 125 Speed feedforward:
Enter a suitable value for your application, e.g. 80%.
4. Select the Motion core wizard > Fine interpolator.
5. 1425 Speed feed forward - interpolation:
Select 1: External - linear v+x or 3: External - quadratic x.
= The controller transfers the values A601 Interpolation data record and A592 Velocity offset.
6.8.4.2 Setting up drive-generated internal feedforward control
1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.
2. Select the Control cascade wizard > Position controller.
3. 125 Speed feedforward:
Enter a suitable value for your application, e.g. 80%.
4. Select the Motion core wizard > Fine interpolator.
5. 1425 Speed feed forward - interpolation:
Select O: Internal - linear v+x, 4: Internal - quadratic x or 5: Internal - cubic x.
= The controller transfers the value A601 Interpolation data record.

6.8.4.3 Without internal feedforward control

1.

Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

Select the Control cascade wizard > Position controller.

125 Speed feedforward:

Enter a value of 0.

The controller only transfers the value A601 Interpolation data record.
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6.9 Interpolation

The interpolation is relevant to the following operating modes:
= |nterpolated position mode
= Cyclic synchronous position mode
= Cyclic synchronous velocity mode

For interpolation, each bus cycle has to return new set values. A602 Interpolation time period is used to define the interval
for this. The value in A602 is transferred to A291 PLC Cycle time. Note that A291 must be equal to or a multiple of A150
Cycle time. A291, A150 and the cycle time of the interpolation routine are used to compute how many single steps a set
value difference has to be divided into. The interpolation routine changes the set value for the internal control every cycle
by a single step.

I A291 | ! .
l — l | ! ! |,
ST A A A O A A A
. Motion core cycle time e

Fig. 28: Interpolation: Ideal behavior over time, no jitter

If a new set value is still not present in the first cycle after the last single step, the set value for the internal control is
extrapolated using the previous increment. The extrapolation ends if a new set value is present or if the specified maximum
extrapolation period 1423 has been exceeded. In the second case, the drive controller changes to the Fault device state. The
event 78:Cyclical position limit is shown on the display with cause 3:0Overrun of max. extrapolation period 1423.

A291

|« >i
Jitter Jitter
«— —>
[ vl !
A150

! | A— ! | ! ! !,
(NEEEEETEEEREREE RN

X A . . O ==
Motion core cycle time |

€ N
'\ Extrapolation

~+V

Fig. 29: Interpolation: Controller jitter over time
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6.10 Touch probe - Examples

The source of the signal for position measurement 1 is set in 1110 (e.g. DI1) and in 1126 for position measurement 2.

The touch probe function is explained using position measurement 1, which is activated using bit 0 to 7. The function of
position measurement 2 is identical and is activated at bit 8 to 15 in parameter A594. The function of position
measurement 1 is shown in the following paragraphs using some examples.

Bit 0

Bit 1

y

A594

Bit 4

y

Bit 5

y

Trigger signal

Y

Bit 0

Bit 1

A595

Bit 2

4
5
-
-

A596

y

4_

A597

2_
1_

y

1 I
t t, i3 ts

Fig. 30: Touch probe: Example 1

If position measurement 1 is switched on (A594 bit 0 = 1), feedback takes place over A595 (bit 0 = 1). The function is
configured to trigger at each event (A594 bit 1 = 1). Triggering at the rising edge of the trigger signal and the falling edge are
both switched on (A594 bit 4 = 1 and bit 5 = 1). Accordingly, the position in A596 (rising edge) and A597 (falling edge) are
written for each edge of the trigger signal. The initial write processes in each case are shown in A595. Bit 1 = 1 means that
triggering occurred at a rising edge; bit 2 = 1 means that triggering occurred at a falling edge. If the position measurement 1
is switched off (A594 bit 0 = 0), all status bits are reset in A595. The positions in A596 and A597 remain intact.
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BitO |

Bit 1

|

A594

Bit 4

Bit 5

y

Trigger signal

BitO |

Bit 1

A595

Bit 2

4
5
-
1

A596

|

3_
2_

A597

\j

1 I
4 t, t3 t,

Fig. 31: Touch probe: Example 2
Unlike the first example, Example 2 is triggered only at the first event (bit 1 = 0). Triggering at the rising edge of the trigger

signal is deactivated and switched on at the falling edge (bit 4 = 0 and bit 5 = 1). Accordingly, the position in A597 (falling
edge) is written for the first falling edge of the trigger signal (t2).
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| | | | .
i I
| |
| |

Bit 1

|

A594

Bit 4

y

Bit 5

y

Trigger signal I

BitO |

Bit 1

Bit2 | ]

4
5
5o
1

A595

\

A596

y

3_
2_

A597

y

1 I
4 t, t3 t,

Fig. 32: Touch probe: Example 3

In Example 3, the position measurement 1 is switched on twice in the displayed time frame (bit 0 = 1), and it is triggered at
the first event in each case (bit 1 = 0). Triggering at the rising and falling edge of the trigger signal is switched on (bit4 =1
and bit 5 = 1). Accordingly, the position is written in A597 (falling edge) for the first falling edge of the trigger signal (t2) and
in A596 for the second rising edge (t3).
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6.11 Cycle times

Possible cycle times can be found in the following table.

Application 1ms,2ms,4ms, 8 ms Adjustable in A150

Inputs and outputs 1ms,2ms,4ms, 8 ms Adjustable in A150°

Tab. 32: Cycle times

6.12 Lag monitoring

In CiA 402 type applications, you can monitor the lag of the axis with active position control in order to detect increasing
position deviations at an early stage. Monitoring the lag allows you to react quickly before material damage can occur, e.g.
in the event of stiffness or a mechanical blockage of the output.

To monitor the lag, the difference between the actual position of the axis and the set position x2,,, of the control is
determined and compared with the maximum permitted lag (actual position: A545; set position: 196; permitted lag: A546;
result: 1187). If the permitted lag is exceeded, event 54: Following error is triggered with the corresponding protection level
(protection level: U22).

3 Partially with timestamp correction with a resolution of 1/64 us
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7 Appendix

1. EtherCAT and CiA 402 standard mapping

7.1 SD6: CiA 402 receive process data

The following table shows the standard mapping for the receive process data in the CiA 402 application. For fieldbus
communication via EtherCAT, the process data mapping is done via parameter A225 — A228. If necessary, the standard
mapping can be customized.

Information

The standard mapping cannot be used for Interpolated position mode and Velocity mode. For more information on process
data mapping for these two operating modes, refer to the descriptions of the respective operating mode (see Operating
modes in detail [»_108]).

WORD Control word A515
Communication object 6040 hex in accordance with CiA 402

2 INT8 Modes of operation A541
Communication object 6060 hex in accordance with CiA 402

3-6 INT32 Target position A567
Communication object 607A hex in accordance with CiA 402

7-10 INT32 Target velocity A638
Communication object 60FF hex in accordance with CiA 402

11-14 INT32 Velocity offset A592
Communication object 60B1 hex in accordance with CiA 402

15-16 INT16 Torque offset A593
Communication object 60B2 hex in accordance with CiA 402

17-18 INT16 Target torque A558
Communication object 6071 hex in accordance with CiA 402

19-22 DWORD Digital outputs A637
Communication object 60FE hex in accordance with CiA 402

Tab. 33: SD6: receive process data (standard mapping)
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71.2

SD6: CiA 402 transmit process data

The following table shows the standard mapping for the transmit process data in the CiA 402 application. For fieldbus

communication via EtherCAT, the process data mapping is done via parameter A233 — A236. If necessary, the standard

mapping can be customized.

The standard mapping cannot be used for Interpolated position mode and Velocity mode. For more information on process

Information

data mapping for these two operating modes, refer to the descriptions of the respective operating mode (see Operating

modes in detail [P 108]).

2

3-6
7-10
11-12
13-16
17-20
21-24
25-26
27-28

WORD

INT8

INT32

INT32

INT16

INT32

DWORD

INT32

WORD
WORD

Statusword

Modes of operation display

Position actual value

Velocity actual value

Torque actual value

Following error actual value

Digital inputs

Additional position actual

value / 1st value

Status word 2

Status word user-defined

Tab. 34: SD6: transmit process data (standard mapping)

A516
Communication object 6041 hex in accordance with CiA 402

A542
Communication object 6061 hex in accordance with CiA 402

A545
Communication object 6064 hex in accordance with CiA 402

A553
Communication object 606C hex in accordance with CiA 402

A564
Communication object 6077 hex in accordance with CiA 402

A632
Communication object 60F4 hex in accordance with CiA 402

A636
Communication object 60FD hex in accordance with CiA 402

A620
Communication object 60E4 hex in accordance with CiA 402

E201
A67
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1.2.1

Supported communication objects

CiA 402 Drives and motion control: 6000 hex — 65FF hex

The following table includes the supported communication objects of the standardized profile CiA 402 Drives and motion

control device profile — Part 2: Operation modes and application data for motion control, as well as how they are mapped

to the corresponding parameters of STOBER.

The communication objects are used in the applications CiA 402 and CiA 402 HiRes Motion.

603F hex
6040 hex
6041 hex
6042 hex
6043 hex
6044 hex
6046 hex
6046 hex
6046 hex
6046 hex
6048 hex
6048 hex
6048 hex
6048 hex
6049 hex
6049 hex
6049 hex
6049 hex
604A hex
604A hex
604A hex
604A hex
604B hex
604B hex
604B hex
604B hex
604C hex
604C hex
604C hex
604C hex

605A hex
605E hex
6060 hex

0 hex
0 hex
0 hex
0 hex
0 hex
0 hex

0 hex
1 hex
2 hex

0 hex
1 hex
2 hex

0 hex
1 hex
2 hex

0 hex
1 hex
2 hex

0 hex
1 hex
2 hex

0 hex
1 hex
2 hex

0 hex
0 hex
0 hex

NIENIENENIEN

<

Error code

Control word

Statusword

vl target velocity

vl velocity demand

vl velocity actual value

vl velocity min max amount
Highest subindex supported
vl velocity min amount

vl velocity max amount

vl velocity acceleration
Highest subindex supported
Delta Speed

Delta Time

vl velocity deceleration
Highest subindex supported
Delta Speed

Delta Time

vl velocity quick stop

Highest subindex supported
Delta Speed

Delta Time

vl set-point factor

Highest subindex supported
vl set-point factor numerator
vl set-point factor denominator
vl dimension factor

Highest subindex supported
vl dimension factor numerator

vl dimension factor
denominator

Quick stop option code
Fault reaction option code

Modes of operation

A514

A515

A516

A517

A518

A519

Array with 2 elements
Constant value of 2 hex
A521[0]

A521[1]

Structure with 2 elements
Constant value of 2 hex
A523[0]

A523[1]

Structure with 2 elements
Constant value of 2 hex
A524[0]

A524[1]

Structure with 2 elements
Constant value of 2 hex
A525[0]

A525[1]

Array with 2 elements
Constant value of 2 hex
A526[0]

A526[1]

Array with 2 elements
Constant value of 2 hex
A527[0]

A527[1]

A536
A540
A541
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6061 hex
6064 hex
6065 hex
6066 hex
606C hex
6071 hex
6072 hex
6076 hex
6077 hex
6078 hex
6079 hex
607A hex
607B hex
607B hex
607B hex
607B hex

607C hex
607D hex
607D hex
607D hex
607D hex
607E hex
607F hex
6081 hex
6083 hex
6084 hex
6085 hex
6087 hex
6091 hex
6091 hex
6091 hex
6091 hex
6092 hex
6092 hex
6092 hex
6092 hex
6098 hex
6099 hex
6099 hex
6099 hex
6099 hex

0 hex
0 hex
0 hex
0 hex
0 hex
0 hex
0 hex
0 hex
0 hex
0 hex
0 hex
0 hex

0 hex
1 hex
2 hex

0 hex

0 hex
1 hex
2 hex
0 hex
0 hex
0 hex
0 hex
0 hex
0 hex
0 hex

0 hex
1 hex
2 hex

0 hex
1 hex
2 hex
0 hex

0 hex
1 hex
2 hex

NN NN RN RN RSN NEN

ANIEN

NN ENIENIEN

ANIRN

IENIEN

ANIRN

RN ENENIEN

ANEERN

Modes of operation display
Position actual value
Following error window
Following error time out
Velocity actual value
Target torque

Maximum torque

Rated torque

Torque actual value
Current actual value

DC link circuit voltage
Target position

Position range limit
Highest subindex supported
Min. position range limit

Max. position range limit

Home offset

Software position limit
Highest subindex supported
Min. position range limit
Max. position range limit
Polarity

Max profile velocity

Profile velocity

Profile acceleration

Profile deceleration

Quick stop deceleration
Torque slope

Gear ratio

Highest subindex supported
Motor revolutions

Shaft revolutions

Feed constant

Highest subindex supported
Feed

Shaft revolutions

Homing method

Homing speeds

Highest subindex supported
Speed during search for switch

Speed during search for zero

A542

A545

A546

A547

A553

A558

A559

A563

A564

A565

A566

A567

Record with 2 elements
Constant value of 2 hex
A568[0]; no function

A568[1]; used as revolution
length

A569

Record with 2 elements
Constant value of 2 hex
A570[0]

A570[1]

A571; only bit 7 has function
A572

A574

A576

A577

A578

A561

Record with 2 elements
Constant value of 2 hex
A584[0]

A584[1]

Record with 2 elements
Constant value of 2 hex
A585[0]

A585[1]

A586

Record with 2 elements
Constant value of 2 hex
A587[0]

A587[1]
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609A hex
60A3 hex
60A4 hex
60A4 hex
60A4 hex
60B1 hex
60B2 hex
60B8 hex
60B9 hex
60BA hex

60BB hex

60BC hex

60BD hex

60CO0 hex
60C1 hex
60C1 hex
60C1 hex
60C2 hex
60C2 hex
60C2 hex
60C2 hex
60C4 hex

60C4 hex
60C4 hex
60C4 hex
60C4 hex
60C4 hex
60C4 hex
60C4 hex
60C5 hex
60C6 hex
60D0 hex

60DO0 hex
60D0 hex
60DO0 hex
60E3 hex

0 hex
0 hex

0 hex
1 hex
0 hex
0 hex
0 hex
0 hex
0 hex

0 hex

0 hex

0 hex

0 hex

0 hex

1 hex

0 hex
1 hex
2 hex

0 hex
1 hex
2 hex
3 hex
4 hex
5 hex
6 hex
0 hex
0 hex

0 hex
1 hex
2 hex

NN N NN

&

NIENENIEN

Homing acceleration

Profile jerk use

Profile jerk

Highest subindex supported
Profile jerk, Profile jerk 1
Velocity offset

Torque offset

Touch probe function

Touch probe status

Touch probe position 1 positive

value

Touch probe position 1
negative value

Touch probe position 2 positive

value

Touch probe position 2
negative value

Interpolation sub mode select

Interpolation data record
Highest subindex supported
1st set-point

Interpolation time period

Highest subindex supported

Interpolation time period value

Interpolation time index

Interpolation data
configuration

Highest subindex supported
Maximum buffer size
Actual buffer size

Buffer organisation

Buffer position

Size of data record

Buffer clear

Max acceleration

Max deceleration

Touch probe source

Highest subindex supported
Touch probe 1 source
Touch probe 2 source

Supported homing methods

A588

A589

Array with 1 element
Constant value of 1 hex
A590

A592

A593

A594

A595

A596

A597

A598

A599

A600

Record with 1 element
Constant value of 1 hex
A601

Record with 2 elements
Constant value of 2 hex
A602[0]

A602[1]

Record with 5 elements

Constant value of 5 hex
A603[0]; no function
A603[1]; no function
A603[2]; no function
A603[3]; no function
A603[4]; no function
A603[5]; no function
A604

A605

Array with 3 elements (see
also Touch probe source:

Values [P 142])

Constant value of 2 hex

1110
1126

Record with 20 elements
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60E3 hex
60E3 hex

60E4 hex

60E4 hex
60E4 hex

60F2 hex
60F4 hex
60FD hex
60FE hex
60FE hex
60FE hex
60FF hex
6502 hex

0 hex
1 hex —14 hex

0 hex
1 hex

0 hex
0 hex
0 hex

0 hex
1 hex
0 hex
0 hex

ANIEN

LNIEN

Highest subindex supported

1st - 20th supported homing
method

Additional position actual
value / 1st value

Highest subindex supported

1st additional position actual
value

Positioning option code
Following error actual value
Digital inputs

Digital outputs

Highest subindex supported
Physical outputs

Target velocity

Supported drive modes

Tab. 35: CiA 402-2 communication objects: 6000 hex — 65FF hex

Constant value of 14 hex

A619[0] — A619[19]

Record with 1 element

Constant value of 1 hex

A620

A621

A632

A636

Record with 1 element
Constant value of 1 hex
A637

A638
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1.2.2 Touch probe source: Values

Column 1 of the following table shows the possible values for the communication object 60D0 hex in accordance with
EtherCAT specification ETG.6010. Column 2 contains the values transferred to DriveControlSuite (Touch probe 1 source:

1110, Touch probe 2 source: 1126).

Value (EtherCAT) Value (DS6)
-100 0: Low

-101 1: High

1 3:DI1

-1 4: DIl inverted

2 5:DI2

-2 6: DI2 inverted

3 7:DI3

-3 8: DI3 inverted

4 9:DI4

-4 10: DI4 inverted
-105 11: DI5

-5 12: DI5 inverted
-106 13: DI6

-6 14: DI6 inverted
-107 15: DI7

-7 16: DI7 inverted
-108 17: DI8

-8 18: DI8 inverted
-109 19: DI9

-9 20: DI9 inverted
-110 21:DI10

-10 22: DI10 inverted
-111 23:DI11

-11 24: DI11 inverted
-112 25:DI12

-12 26: DI12 inverted
-113 27:DI13

-13 28: DI13 inverted

Tab. 36: Values for 60D0 hex

Manufacturer-specific

Manufacturer-specific

Digital input 1 (Touch probe input)

Manufacturer-specific

Digital input 2 (Touch probe input)

Manufacturer-specific

Digital input 3 (Touch probe input)

Manufacturer-specific

Digital input 4 (Touch probe input)

Manufacturer-specific
Manufacturer-specific
Manufacturer-specific
Manufacturer-specific
Manufacturer-specific
Manufacturer-specific
Manufacturer-specific
Manufacturer-specific
Manufacturer-specific
Manufacturer-specific
Manufacturer-specific
Manufacturer-specific
Manufacturer-specific
Manufacturer-specific
Manufacturer-specific
Manufacturer-specific
Manufacturer-specific
Manufacturer-specific

Manufacturer-specific
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71.2.3 Manufacturer-specific parameters: 2000 hex - 53FF hex
Index, subindex and calculation example

Information

Index and Subindex must be specified in the format required by the controller.

Information

The calculation described below is only valid for converting the manufacturer-specific parameters.

The index is calculated from the group and line of the parameter according to the following formula:
Index = 8192 + (number of the group x 512) + number of the line

The subindex for simple parameters is always 0.
For array or record parameters, the subindex for EtherCAT Rx corresponds to the element number of the parameter.

The subindex for EtherCAT Rx SDO Info corresponds to the element number of the parameter + 1 for array or record

parameters.

_ Simple parameters Array or record parameter
Index 8192 + (number of the group x 512) + number of the line
Subindex for EtherCAT Rx 0 Element number
Subindex for EtherCAT Rx SDO Info 0 Element number + 1

Tab. 37: Index and subindex for manufacturer-specific parameters

Calculation example

Calculation for parameter E200[0]:

Number of the group =4

Number of the line =200

Index = 8192 + (4 x 512) + 200 = 10440 = 28C8 hex
Subindex for EtherCAT Rx = 0 = 0 hex

Subindex for EtherCAT Rx SDO Info =1 =1 hex

143



7 | Appendix

STOBER

Communication objects

The following table includes the supported communication objects and how they are mapped to the corresponding

parameters of STOBER.

2000 hex — 21FF hex
2200 hex — 23FF hex
2400 hex — 25FF hex
2600 hex — 27FF hex
2800 hex — 29FF hex
2A00 hex — 2BFF hex
2C00 hex — 2DFF hex
2EQ0 hex — 2FFF hex
3000 hex — 31FF hex
3200 hex — 33FF hex
3400 hex — 35FF hex
3600 hex — 37FF hex
3E00 hex — 3FFF hex

4000 hex — 41FF hex

4200 hex — 43FF hex
4400 hex — 45FF hex
4600 hex — 47FF hex
4800 hex — 49FF hex
5200 hex — 53FF hex

Tab. 38: Manufacturer-specific communication objects: 2000 hex — 53FF hex

A: Drive controller
B: Motor

C: Machine

D: Set value

E: Show

F: Terminals

G: Technology
H: Encoders

I: Motion

J: Motion blocks
K: Control panel
M: Profile

P: Customer-specific
parameters

Q: Customer-specific
parameters, instance-
dependent

R: Production data
S: Safety
T: Scope

U: Protection functions

Z: Fault counter

O 0 N OO B~ W N

R e
S S

=
)]

17
18
19
20
25

A00 —A511
BOO -B511
C00-C511
D00 - D511
EO0 - E511
FOO - F511
G00-G511
HOO — H511
100-1511
JOO-1J511
KOO — K511
MO00 - M511
P00 - P511

Q00-Q511

ROO-R511
S00-S511
TO0O-T511
u00-U511
Z00-17511
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7.3 Detailed information

The documentation listed below provides you with further relevant information on the 6th STOBER drive controller

generation. The current status of the documentation can be found in our download center at:

http://www.stoeber.de/en/downloads/.

Enter the ID of the documentation in the search field.

S [ TN

EtherCAT communication — SD6

CANopen communication — SD6

SD6 drive controller

ST6 safety technology — STO via
terminals

SE6 safety technology — Safe drive
monitoring via terminals

Motion commands

Manual

Manual

Manual

Manual

Manual

Manual

Installation, electrical installation,
data transfer, commissioning,
diagnostics, detailed information

Installation, electrical installation,
data transfer, commissioning,
detailed information

System design, technical data,
project configuration, storage,
installation, connection,
commissioning, operation, service,
diagnostics

Technical data, installation,
commissioning, diagnostics,
detailed information

Technical data, installation,
commissioning, diagnostics

Control and status information,
denials and limitations, motion

442516

442637

442426

442478

442796

443349

Additional information and sources that form the basis of this documentation or are referenced by the documentation:

Beckhoff Automation GmbH & Co. KG (publisher): EtherCAT System Documentation. Version 5.1. Verl, 2016.

A free basic version of the TwinCAT 3 automation software is available at

https://www.beckhoff.com/en-us/products/automation/twincat/te 1xxx-twincat-3-engineering/te1000.html.

EtherCAT Technology Group (ETG), 2015. ETG.1300: EtherCAT Indicator and Labeling. ETG.1300 S (R) V1.1.0. Specification.

2015-07-03.
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1.4

Formula symbols

E
M
n

ny
n,

Vlset,cycl

Vlset

X

Xlset,cycl

Xlset

N

Nm
rpm
rpm
rpm

m/min

m/min

Force

Torque

Speed

Speed at gearbox input
Speed at the gearbox output

Set velocity transmitted cyclically by the fieldbus and interpolated and processed
directly

Set velocity for calculating the motion profile
Position

Set position transmitted cyclically by the fieldbus and interpolated and processed
directly

Set position for calculating the motion profile
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1.5

ALT
CAN
CiA
CNC
csp
cst
csv
DI
EoE
ESI
ETG
EtherCAT
I/0

LS

LSB

M/F

MAC
MDevice
MEnc

NC

PDO

PEnc

PLL

pp
PROFINET
pt

pv

RS

RxPDO

S
SubDevice
SYNC

TwinCat

TxPDO
vl

P

Abbreviations

Alternative

Controller Area Network

CAN in Automation
Computerized Numerical Control
Cyclic synchronous position mode
Cyclic synchronous torque mode
Cyclic synchronous velocity mode
Digital Input

Ethernet over EtherCAT

EtherCAT SubDevice Information (device description of an EtherCAT SubDevice)
EtherCAT Technology Group
Ethernet for Control Automation Technology
Input/Output

Interpolated position mode
Internet Protocol

Linear Motor

Limit Switch

Least Significant Bit

Torque or force

Media Access Control
MainDevice

Motor Encoder

Numerical Control

Process Data Objects

Position Encoder

Phase Locked Loop

Profile position mode

Process Field Network

Profile torque mode

Profile velocity mode

Reference Switch

Receive PDO (receive process data)
Switch

SubordinateDevice
Synchronization

The Windows Control and Automation Technology (automation software from Beckhoff
Automation GmbH)

Transmit PDO (transmit process data)
Velocity mode

Zero Pulse
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8 Contact

8.1 Consultation, service and address

We would be happy to help you!

We offer a wealth of information and services to go with our products on our website:
http://www.stoeber.de/en/service

For additional or personalized information, contact our consultation and support service:

http://www.stoeber.de/en/support

If you need our system support:
Phone: +49 7231 582-3060
systemsupport@stoeber.de

If you need a replacement device:
Phone: +49 7231 582-1128
replace@stoeber.de

Call our 24-hour service hotline:
Phone: +49 7231 582-3000

Our address is:

STOBER Antriebstechnik GmbH + Co. KG
Kieselbronner Strasse 12

75177 Pforzheim, Germany

8.2 Your opinion is important to us

We created this documentation to the best of our knowledge with the goal of helping you build and expand your expertise

productively and efficiently with our products.

Your suggestions, opinions, wishes and constructive criticism help us to ensure and further develop the quality of our

documentation.

If you want to contact us for a specific reason, we would be happy to receive an e-mail from you at:

documentation@stoeber.de

Thank you for your interest.
Your STOBER editorial team
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8.3 Close to customers around the world

We offer you committed, expert advise and support in over 40 countries worldwide:

STOBER AUSTRIA
www.stoeber.at

+43 7613 7600-0
sales@stoeber.at

STOBER FRANCE
www.stober.fr
+33 478 98 91 80
sales@stober.fr

STOBER ITALY
www.stober.it
+39 02 93909570
sales@stober.it

STOBER KOREA
www.stober.kr
+82 10 5681 6298
sales@stober.kr

STOBER SWITZERLAND
www.stoeber.ch

+41 56 496 96 50
sales@stoeber.ch

STOBER TURKEY
www.stober.com

+90 216 510 2290
sales-turkey@stober.com

STOBER USA
www.stober.com
+1 606 759 5090
sales@stober.com

STOBER CHINA
www.stoeber.cn
+86 512 5320 8850
sales@stoeber.cn

STOBER Germany
www.stoeber.de
+49 7231 582-0
sales@stoeber.de

STOBER JAPAN
www.stober.co.jp
+81-3-5875-7583
sales@stober.co.jp

STOBER SWEDEN
www.stober.com

+46 702 394 675
neil.arstad@stoeber.de

STOBER TAIWAN
www.stober.tw
+886 4 2358 6089
sales@stober.tw

STOBER UK
www.stober.co.uk
+44 1543 458 858
sales@stober.co.uk
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Broadcast domain

Logical grouping of network devices within a local network that reaches all nodes via broadcast.

CiA 402

Application of the commissioning software, which includes both the controller-based and drive-based operating modes

(csp, csv, cst, ip, pp, Vi, pv, pt).

CiA 402 HiRes Motion

Application of of the commissioning software, which includes both the controller-based and drive-based operating
modes (csp, csv, cst, ip, pp, v, pv, pt). The interface for the controller is tailored to the HiRes CODESYS device driver,

meaning that set and actual values are represented and transmitted in units that can be defined by the user.

DC-Sync

Also: Synchronization using distributed clocks. Method for EtherCAT network synchronization. Each EtherCAT
SubDevice with distributed clocks functionality has a local clock. Normally, the time from the first DC-Sync-capable
EtherCAT SubDevice downstream of the MainDevice in the network serves as the reference time: Both the MainDevice
and the SubDevices synchronize with this reference clock when prompted by the MainDevice. The event belonging to a

synchronization is labeled as a Sync 0 signal and is generated cyclically by the SyncManager of each SubDevice.

ESI file

Device description file for EtherCAT SubDevices. In accordance with ETG.2000: XML file that contains all relevant data
for an EtherCAT node in the EtherCAT system, such as the identity of the manufacturer, the product code, the version

or the production number. The EtherCAT MainDevice requires this file to configure the EtherCAT system.

IPv4 limited broadcast

Type of broadcast in a network with IPv4 (Internet Protocol version 4). The IP address 255.255.255.255 is entered as

the destination. The content of the broadcast is not forwarded by a router, which limits it to the local network.

Process Data Objects (PDO)

Communication objects in a CANopen or EtherCAT network that transmit data such as set and actual values, control
commands or status information based on events or objectives, in cycles or in real time on request. PDOs are generally
exchanged over the process data channel with high priority. Depending on the view of the respective node, a
distinction is made between receive PDOs (RxPDO) and transmit PDOs (TxPDO).

SDO Info

Service that enables the EtherCAT controller to read out objects from the drive controller. During the read-out, all
relevant object properties, such as data type, write and read access rights as well as mapping capabilities, are

transmitted to the controller.
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SM-Sync

Also: Synchronization using SyncManager event. Method for EtherCAT network synchronization where the EtherCAT

SubDevices synchronize with an event from incoming data.

Startup list

Predefined list of CiA objects that is processed every time EtherCAT is started. The values it contains are sent to the
corresponding EtherCAT SubDevice with the defined state change.

Synchronization

Time synchronization of EtherCAT network nodes that allows the EtherCAT MainDevice and SubDevices to work
synchronously with each other in the same cycle. EtherCAT provides two different methods for precisely synchronizing
the MainDevice and SubDevices: a SyncManager event (SM-Sync) and distributed clocks (DC-Sync). The FreeRun state

exists if the MainDevice and SubDevices are not synchronized.
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